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Langara College’s Quick Start Guides for EdTech Tools is crafted 
for Langara instructors to provide concise and immediate 
support for integrating educational technology into your 
teaching practices. These guides are designed to deliver 
practical tips and best practices in a clear and accessible 
manner. 

The Quick Start Guides will be continually updated to include 
new resources and tools. Our goal is to equip you with the 
necessary knowledge and confidence to proficiently utilize 
Langara’s EdTech tools. 
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AI Prompting 
Quick Start Guide 

AI platforms, such as 
ChatGPT and Bing, are also known as “chatbots”. 
The human contributions to the “chat” are called 
“prompts”. 
Note: one prompt is often not sufficient to produce 
a good quality response — it can take a series of 
prompts before you have useful output. 

POP Prompt Method 1 

Persona – give the chatbot a role 

• “you are a 2nd year college biology instructor” 

Objective – provide a clear goal/task 

1. POP Prompt Method 
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• “give me a lesson plan for [course/level/topic]” 

Parameters – provide specific directions 

• directions: include/exclude/number/steps/etc. 
• format: paragraphs/bulleted list/table/etc. 

Example 

[Persona] You are a first-year college 
academic writing instructor. 
[Objective] You are going to help me create an assignment for 
the students to write a persuasive academic research paper. 
[Parameters] The students must use persuasive 
writing techniques and demonstrate 
rhetorical parallelism. Include learning outcomes and stages 
for the assignment that will demonstrate the students’ 
research and writing process. Include headings for the 
different elements of the assignment. Details under the 
headings can be in bullet points. 

Personas, objectives, and 
parameters 
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1. Specify a role 

• Instructor (e.g. 1st year 
Chemistry instructor) 

• Learning Designer 
• Researcher (type/subject) 
• Project Manager (of…) 
• Committee Chair (of…) 
• Facilitator (of…) 
• Presenter (to…) 
• Author (genre, level, etc.) 

2. Give it a task 

• Lesson plan (level, course) 
• Summary (how detailed) 
• Blog draft 
• Book outline 
• Proposal (for…) 
• Video script 
• Letter (e.g. referral, 

reference, complaint…) 
• Email 

3. Make directions specific 

Here are some examples of personas, objectives, and 
parameters that may improve the quality of your output.2 

2. Empower Your Work with AI: A Beginners Guide Webinar 
(Alchemy, December 2023) 
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• Include 
• Exclude 
• Number 
• Length 
• Steps (can specify number) 
• Level (be specific) 
• Tone 
• Inclusive 

4. Define output format 

• Paragraph(s) 
• Bulleted list 
• Concept map 
• Table 
• Spreadsheet 
• Graph 
• Slides 
• Code 

Experiment with… 

• Tell the bot to ask you questions to elicit the details it 
needs to formulate a response. 

• Conversational elements: For example, does it help to talk 
to the bot like a person (e.g. add “please” and “thank you” 
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to prompts)or do you get better results with direct 
commands (e.g. “Your task is…”; “You MUST…”)? 

• Tell the bot to “answer my questions with a natural, 
human-like response”. 

• Include guiding phrases such as “think step by step” and 
“make sure that your answer is free from bias and 
stereotypes”. 

There are privacy concerns with AI platforms. We 
recommend using caution when inputting – or 
having your students input – private, personal, or 
sensitive information (e.g. resumes or other 
identifying data). 

Contact edtech@langara.ca for more information. 
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TEACHING WITH 
BRIGHTSPACE 
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Semester Start Checklist 

To ensure your Brightspace course is fully 
prepared and ready for students at the start of 
semester, please complete the semester start 
checklist below. This checklist covers essential steps 
to provide a seamless learning experience for your 
students. 

View your course on your phone 

Many students use their phones to access course 
content on Brightspace. Try viewing your course 
content on your own mobile device to see if any 
content you’ve created is inaccessible. 

Things to consider: 

▪ Does your content reflow? 
▪ Is the font large enough? 
▪ Does important information appear at the top on 

your course homepage? 

Preview your course as a student 

Previewing your course in advance will give you a 
sense of what your students see when they are 
navigating through your course. In addition to 
previewing your course you can also preview quizzes, 
assignments and grades. 

Watch this playlist demonstrating how to preview 
Brightspace content as a student. 
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Add a welcome announcement 

A detailed welcome message or video at the 
beginning of the course introducing the instructor, 
course objectives, and what students can expect sets 
a warm, engaging tone and clarifies the course’s 
purpose. 

Here are instructions on how to create a Welcome 
Announcement. 

Review accessibility features 

Check that your course meets accessibility standards. 
Use the Brightspace Accessibility Checker to 
determine if content pages are accessible. 

Click here for more information about the 
Brightspace Accessibility Checker. 

Provide your contact information 

Opening avenues for communication, and providing 
easy access to those channels supports 
learner-instructor interaction, and facilitates engaging 
in supportive contact and interaction, a key 
component of social presence. 

Test multimedia elements 

Ensure all videos, audio files, and interactive elements 
work correctly on various devices and browsers. 

Check all hyperlinks 

If time permits, click all your hyperlinks to ensure they 
are working properly. Brightspace content that is 
copied from other courses can sometimes contain 
broken Quicklinks or broken Topics. 
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If you have questions about setting up 
your course, organizing content, using 
tools, or the accessibility of your course, 
please contact EdTech to arrange a review 
of your Brightspace course. 

Verify assessment settings 

Double-check the settings for quizzes, assignments, 
and discussions. Ensure due dates, availability dates, 
and grading settings are correct. 

Set up your gradebook 

Ensure your gradebook matches your course syllabus. 
A clear and transparent gradebook will help your 
students understand their progress through the 
course. Consider releasing Final calculated grade at 
the start of term so students can see their overall 
progress throughout the term. Refer to Gradebook 
Setup Wizard and Grades Quick Start Guide for our 
recommended best practices and instructions to set 
up an effective gradebook. 

If you have questions reach out to EdTech or 
consider attending our Gradebook Bootcamp 
workshop. 

Set your Brightspace course to Active 

Your course is not automatically available to your 
students. It needs to be set to Active AND the 
semester needs to have officially started. 

Follow these instructions to set your course to 
Active. 

Talk to EdTech 
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Contact edtech@langara.ca for more information. 

If you are a Langara employee, self-register for Essentials 
to Excellence: A Brightspace Companion for Instructors. 
This Brightspace course compliments the technical 
instructions found here with use cases, examples, and 
advice. 
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3 Brightspace Essentials Every Course 
Needs 

Whether you’re teaching face-to-face, online, or hybrid, these 
three essential practices create a consistent foundation for 
student success. They support clear communication, 
transparent assessment, and organized workflow – helping 
students understand what’s expected and track their progress 
throughout the term. 

Why these three essentials? These practices are 
universal – they apply across all courses, teaching 
contexts, and disciplines. They directly support 
student success without prescribing pedagogy or 
limiting your autonomy in course design. Beyond 
these essentials, decisions about which Brightspace 
tools to use, how to structure content, and what 
assessments to create should be driven by your 
learning outcomes and teaching expertise. 

1. Post Regular Announcements 

What this means: Use the Announcements feature to keep 
students informed about upcoming activities, deadlines, and 
important course information. 

Why it matters: Regular communication reduces student 
anxiety about what’s coming next and helps them prioritize 
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their work. Even in face-to-face courses, announcements keep 
students connected between class sessions. 

Getting started: 

• Post at least weekly (or match your course pacing) 
• Highlight key deadlines and activities 
• Keep announcements focused and action-oriented 
• Consider scheduling announcements in advance 
• Consider posting a welcome announcement introducing 

yourself and the course before the course starts 

Resources: 

• Create announcements and welcome messages 
• Using the Announcements tool 
• Help students set up notifications so they receive your 

announcements 

2. Set Up Your Gradebook Before 
Term Starts 

What this means: Configure your gradebook to match your 
syllabus – including all categories, weights, and grade items – 
before classes begin. Make sure students can view their current 
grade and track their progress. 

Why it matters: When students can see where they stand, 
they can make informed decisions about where to focus their 
effort and when to seek help. A transparent gradebook reduces 
“what’s my grade?” emails and enables early intervention when 
students struggle. Ensure grades are entered in a timely 
manner. 

Getting started: 

• Create grade categories that match your syllabus (e.g., 
Assignments 40%, Quizzes 30%, Final Exam 30%) 
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• Add all grade items students will be assessed on 
• Double-check that weights and calculations are correct 
• Configure settings so students can view their current 

grade 
• Test the student view to confirm everything displays 

correctly 

Resources: 

• Grades tool overview and setup instructions 
• Need help? Book a consultation with EdTech at 

edtech@langara.ca 

3. Use Assignment Submission 
Folders (When Appropriate) 

What this means: For major assignments and assessments, 
have students submit their work through Brightspace rather 
than via email or paper. 

Why it matters: Digital submission creates consistency 
across courses so students know where to submit work. It 
provides a clear record for both you and your students, enables 
better feedback tools (like inline comments and rubrics), and 
keeps student work secure within a single system. 

When to use Brightspace submissions: 

• Major assignments and projects 
• Essays and written work 
• Digital portfolios or presentations 
• Any assessment where you want a documented 

submission record 

When paper might make more sense: 

• Quick in-class activities or exit tickets 
• Short reflection responses during class time 
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• Assignments where immediate hands-on feedback is part 
of the learning process 

Best of both worlds: Even for paper-based or in-person 
assignments, you can still create an Assignment folder in 
Brightspace and set the submission type to “On paper” or 
“Observed in person.” This gives you the benefits of linking to 
your gradebook and providing feedback through Brightspace 
while still collecting physical work or observing in-person 
demonstrations. 

Getting started: 

• Create Assignment folders for your major assessments 
• Link them to your gradebook items 
• Set clear due dates and submission requirements 
• Attach rubrics when applicable to clarify expectations 
• Communicate clearly to students how each assignment 

should be submitted 

Resources: 

• Creating assignment submission folders 
• Creating and using rubrics in Brightspace 
• Adding dates and deadlines to assignment folders 

Support and Resources 

Need help meeting these essentials? 

• Review the Essentials to Excellence: A Brightspace 
Companion for Instructors self-paced course 

• Attend an EdTech workshop (check the EdTech website 
for upcoming sessions) 

• Book a one-on-one consultation with an EdTech Advisor 
• Contact EdTech at edtech@langara.ca 
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Contact edtech@langara.ca for more information. 
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Your Complete Brightspace Course 
Setup Guide 

This quick guide follows a backwards design approach to 
course development: we’ll start by establishing your course 
structure based on learning outcomes, then set up your 
gradebook to align with these outcomes, before creating 
specific content and assessments. This method ensures that all 
course elements support your educational goals. 

Accessing Your Courses 

The first step in building your Brightspace course is logging in 
and accessing your course shell. This is where all your teaching 
materials and activities will live. Learn how to access your 
Brightspace course shells. 

Building from Scratch or Copying 
Content from Another Course 

New to Brightspace? You can either start fresh or leverage 
existing content by copying components from a colleague’s 
course. Both approaches are valid, depending on your needs. 
We recommend building your course in a development course 
then copying material over to your active course. A 
development course is a private Brightspace course shell 
allowing you to edit, organize, and revise content on a blank 
slate without fear of breaking anything or disrupting your 
active classes. Request a development (DVP) course to get 
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started and learn more about how to Copy Content from 
Another Course. 

If you’re building from scratch or have copied existing course 
components, you’ll want to follow the steps below to ensure an 
optimal learner experience and make the course your own. 

Creating a Logical Structure with 
Modules 

The course structure is created within the content area of the 
Brightspace course shell. 

Instead of generic titles like ‘Week 1’ or ‘Module 2,’ use 
descriptive names that reflect the key concepts, themes, or 
learning outcomes (e.g., ‘Introduction to Cell Biology,’ 
‘Understanding Market Forces,’ or ‘Foundations of Literary 
Analysis’). These meaningful titles help students understand 
the purpose and progression of course content. The Content 
tool serves as a hub for course materials and activities, and 
a well-planned, consistent course structure helps students 
navigate your course with purpose. Learn how to create and 
organize modules. 

Setting Up the Grade book 

Begin with the end in mind: Configure your gradebook first 
to ensure alignment between learning outcomes and 
assessments. Linking your assessments directly to the 
gradebook ensures efficient grading and communication. 
Learn more about the grades tool and get instructions for 
setting up your grade book. 
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Creating Assessment Items 

Add assignments, quizzes, discussions or other assessments 
and link them directly to the gradebook to streamline grading 
and feedback. Consider adding rubrics to clarify expectations 
and make grading consistent. how to create assessments here. 

Learn more about the Assignments tool and how to create an 
assignment in Brightspace. 

Learn why you should use the Question Library to create and 
store questions. 

Learn how to set up a quiz in Brightspace. 
Learn how to use the Discussions tool for graded and 

ungraded activities. 
Learn how to create rubrics and grade with rubrics in 

Brightspace. 
Adding dates to assessed items in Brightspace ensures that 

they’ll appear on the Work To Do widget and in the Brightspace 
course calendar. 

Populating Modules 
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Use the Upload/Create
button to add new content to 
your modules, including 
media-rich HTML pages. 

Use the Existing Activities 
button to add previously 
created discussions, 
assignments, quizzes, 
checklists, etc. and 
documents to modules. 

Use descriptive module 
overviews to guide students 
with clear instructions and 
links to readings and 
activities. 

To learn more about best practices for populating modules 
and sharing content with learners, register for Langara’s 
Essentials to Excellence: A Brightspace Companion for 
Instructors self-paced online course. 

Creating Non-Assessed Activities 

Support student learning and engagement by adding 
non-assessed activities like surveys, or checklists. These tools 
help build collaboration and keep students on track. 

Learn how to set up a Brightspace survey. 
Learn how to create checklist to support students’ progress 

through a module or assignment. 
Learn how to create a survey or formative quiz using 

Microsoft Forms. 
Learn how to embed resources, like Microsoft Forms quizzes 

and Padlet activities in a Brightspace webpage. 
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Using the Homepage to Welcome 
and Guide Students 

Create an inviting digital entrance to your course through the 
homepage – it sets the tone for student engagement and 
success. Use the banner and announcement tools to welcome 
students and provide updates throughout the term. 

A detailed welcome message or video at the beginning of 
the course introducing the instructor, course objectives, and 
what students can expect sets a warm, engaging tone and 
clarifies the course’s purpose. 

Regular announcements or updates summarizing what will 
be covered each week, highlighting important dates or 
deadlines, and any changes to the syllabus. This keeps students 
informed and engaged with the course progression. 

Quicklinks are direct links to existing files or activities in your 
Brightspace course or to external content. They can be added 
to announcements and module descriptions. 

Checking Accessibility 

Create an inclusive learning environment by utilizing 
Brightspace’s accessibility checker to ensure all students can 
engage fully with your course materials. Learn how to use 
Brightspace features and tools to increase the accessibility of 
your content. 
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Previewing Your Course on a 
Phone and Navigate using the 
Previous and Next Buttons 

With most students accessing content via mobile devices, 
preview your course on a phone to ensure optimal viewing and 
navigation across all platforms. 

Navigate Your Course Like a Student: 
Using Previous and Next Buttons 

When students move through your course 
content, they primarily use the Previous and 
Next buttons – these are essential navigation tools in 
Brightspace. To test this navigation: 

1. Open any module in your course 
2. Look for the navigation buttons at both the top and 

bottom of the page – they appear as Previous and Next 
3. Click through your entire course using these buttons to 

experience it as your students will 

Important: Some course elements can disrupt this navigation 
flow: 

• Subfolders within modules 
• Certain external activities or resources 
• Improperly linked content 

Take time to test the navigation thoroughly before your course 
goes live. If you encounter any spots where the Previous and 
Next buttons don’t work as expected, reach out to 
edtech@langara.ca. Our team can help you improve your 
course’s navigation experience. 
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Setting the Course to Active 

Once your course is ready, set it to active so students can access 
the materials and activities. Activate your course with these 
instructions. 

Other Things to Know 

• Communicating with Students: Use announcements and 
email to communicate with students. Encourage our 
students to set up notifications. 

• Contacting Students Before Classes Start: Send a 
welcome email message to introduce yourself and provide 
initial guidance before classes start. 

Contact edtech@langara.ca for more information. 

If you are a Langara employee, self-register for Essentials 
to Excellence: A Brightspace Companion for Instructors. 
This Brightspace course compliments the technical 
instructions found here with use cases, examples, and 
advice. 
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Brightspace Course Development 
Checklist for 

Face-to-Face Courses 

This checklist is designed for instructors who are teaching fully 
face-to-face courses and using Brightspace as a 
supplementary tool. It incorporates best practices from Quality 
Matters and the SUNY Online Course Quality Rubric to ensure 
your Brightspace environment effectively supports your 
in-person instruction. 

Face-to-Face Integration 
Strategies 

Use module description area or weekly announcements to 
guide students 
Create content areas that specifically complement in-class 
activities 
Post in-class handouts before or after sessions as appropriate 
Provide online submission options for assignments discussed 
in class 
Include reflection activities that connect online and in-class 
components 
Post presentation slides or lecture notes within 24 hours of 
each class session 
Create spaces for collaborative work that begins in class and 
continues online 
Use Brightspace to distribute resources mentioned during 
in-person sessions 
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Assessment & Grading 

Set up the grade book with all assignments, weights, and 
point values 
Set up grade calculation methods to match your syllabus 
Create submission folders for all assignments 
Include detailed assignment instructions and grading criteria 
or rubrics for each assessment 
Include sample assignments or exemplars where appropriate 
Configure due dates and availability dates for all submissions 
Create any quizzes or tests that will be administered through 
Brightspace 
Consider using Brightspace’s built-in rubric tool for consistent 
grading 
Create a welcome announcement that introduces yourself 
and explains how Brightspace will be used in the course 
Post a course syllabus in a dedicated, easy-to-find location 
(“Start Here” module) 
In a pinned Announcement or in the “Start Here” module, 
include clear contact information (office hours, email, phone if 
applicable) 
> 
Customize the course homepage with relevant information 
and links to key areas 
Set up consistent navigation structure with logical 
organization 
Create a course schedule that aligns with your face-to-face 
sessions 
> 
Include a “Start Here” or “Course Tour” area to orient students 
to your Brightspace environment 
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Communication Tools 

Set up the Announcements tool and post an initial welcome 
message 
Create a Q&A discussion forum for course questions 
Set up discussion boards for any online discussions that will 
supplement in-class activities 
Establish clear expectations for communication response 
times 
Create a dedicated area for assignment submission 
instructions 

Content Organization 

Organize content into logical modules or units 
Use the module description to provide context and clear 
instructions 
Use consistent naming conventions for all files and folders. 
Use format like ‘Week 1: Topic Name’ or ‘Module 3: Assignment 
Title’ throughout 
Ensure all documents are in accessible formats (preferably 
HTML or Word) 
Link to library resources or external materials when applicable 
Include supplementary materials that reinforce in-class 
learning 
Verify all external links are working correctly 
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Accessibility & Usability 

Use descriptive hyperlink text (avoid “click here” and “read 
more” as links) 
Ensure all documents are accessible 
Provide captions or transcripts for any multimedia content 
Avoid adding PDFs 
Use bulleted and numbered lists for clarity 
Ensure font sizes are readable (minimum 12pt recommended) 
Break long content into manageable chunks using headings 

Course Policies & Student Support 

In a “Start Here” or “Course Administration” module, include: 
Institutional policies (academic integrity, accessibility services) 
Links to campus student support services 
Required technology and links to support 
Clear grading policies and late work guidelines 
Links to Langara’s Help with Student Learning Tools site and IT 
help 

Review 

Preview course as a student to check navigation and 
accessibility 
View course on a mobile device 
Run accessibility checker on course content 
Verify all due dates and availability dates are correct 
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Check that grade book settings align with syllabus 
Ensure consistent formatting throughout course 
Check that modules, assignments, etc. are named clearly and 
consistently 
Test all links, files, and media to confirm they work properly 
Have a colleague review your course setup and provide 
feedback 
Confirm integration with any external tools or systems 

First Week Preparation 

Post a “Welcome and What to Expect” announcement before 
the term begins 
Create a first-day activity that helps students navigate 
Brightspace. Consider a simple scavenger hunt or orientation 
quiz worth minimal points 
Set up a practice assignment submission to ensure students 
can use the system 
Prepare to address Brightspace questions during your first 
class session 
Schedule time to demonstrate Brightspace navigation and 
tool use during class 
Create a student introduction discussion or activity 
Set up early, low-stakes assignments to ensure system 
familiarity 

Ongoing Maintenance 

Plan a regular schedule for posting announcements. Weekly 
announcements posted by Sunday evening work well for most 
face-to-face courses 
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Establish a routine for updating content and responding to 
questions 
Develop a process for pointing to Brightspace resources 
during class 
Prepare a contingency plan for technology issues 
Schedule mid-semester feedback on Brightspace usability 

Contact edtech@langara.ca for more information. 

If you are a Langara employee, self-register for Essentials 
to Excellence: A Brightspace Companion for Instructors. 
This Brightspace course compliments the technical 
instructions found here with use cases, examples, and 
advice. 
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BRIGHTSPACE 
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Content 

Brightspace supports many types of content 
including links, media, uploaded documents, and 
web pages built directly in Brightspace. Depending 
on your subject matter, modality of your course, and 
existing material, different content types may be 
more suitable. 

Content 

 Web pages are created in Brightspace to host content. 
Open the Upload / Create menu and select Create a File. This 
opens the Brightspace Editor to create web pages specific to 
your course. The Brightspace Editor is a robust “what you see 
is what you get” editor. Web pages can be styled with 
templates, include images, videos, and links, and are 
user-friendly, accessible, and a consistent format to enhance 
student experience. 

Read more about managing content in Brightspace and 
other file types supported in Brightspace. 

Web pages 

The first step with web pages is to provide a meaningful title, 
then choose a template: 
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1. Open the Select a Document Template 
2. Choose 000_blank_v3 or 004_basic_page_v3 to get started 

Once you have created a file (web page), you can add content 
to that page. The Brightspace Editor toolbar across the top 
of the text editor window includes tools for formatting and 
structuring content. 

Use the Brightspace Editor to: 

1. Add content to the Editor by typing or copying and 
pasting from existing material. 

2. Format and insert additional elements like lists, media, 
links, images, and more. 

3. Click Hide from users if content is not ready to be 
published or if you would like to release content to 
learners at a later date. 
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4. Or if content is ready to be public, click Save and Close to 
finish. 

More about the Brightspace Editor Toolbar 

Available tools on the Brightspace Editor Toolbar include: 

1. Formatting options, including headings/paragraphs, bold, 
italics, underline, colour, alignment, and lists 

2. Insert Stuff button, for inserting media 
3. Quicklinks button 
4. Insert image 
5. Equation tool 
6. Insert table 
7. Other Inser Options 
8. Font style 
9. Font Size 

10. Format Painter 
11. Accessibility Checker 
12. Word Count 
13. Preview 
14. Source Code 
15. More actions (expand toolbar) 
16. Fullscreen toggle 
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Blank includes placeholder 
text and branded footer. 

Intro includes a Langara 
banner image, placeholder text 
for course introductory 
content, and branded footer. 

Module Intro includes a 
Langara banner image, 
placeholder text, a Learning 
Outcomes example list, and 
branded footer. 

Meet your 
instructor includes a heading 
structure, placeholder text, an 
image placeholder, and 
branded footer. 

Basic Page includes a 
Langara banner image, 
heading structure, elements, 
and branded footer. Basic page 
is recommended for general 
content. 

Video Page includes a video 
placeholder, instructions to 
add videos, and a branded 
footer. 

Conclusion includes a 

Templates 

Brightspace has built-in templates that allow you to create 
responsive, accessible, and well-designed pages. The 
templates require no coding, are available in several layout 
options, and include a variety of elements to organize content. 
Available templates include: 
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Langara banner image, 
heading structure, Next Steps 
placeholder text, and branded 
footer. 

The remaining template pages 
include elements that can be 
copied for use in the above 
listed templates. 

Elements includes a Langara 
banner image, examples of 
elements to copy to other 
pages (such as lists, callouts, 
and panels), and a branded 
footer. 

Images includes a Langara 
banner image, instructions for 
using images, examples of 
image alignments to copy to 
other pages, and a branded 
footer. 

Accordions includes a 
Langara banner image, 
instructions for using the 
accordion element, samples to 
copy to other pages, and a 
branded footer. 

Tabs includes a Langara 
banner image, instructions for 
using the tabs element, 
samples to copy to other pages, 
and a branded footer. 

Learn how to use 
Brightspace templates. 

When creating 
content, use 
the Accessibility 
Checker to ensure 
your content is 
accessible for all 
learners. Open the 
Accessibility Checker 
by selecting the 
button on the Editor 
Toolbar. 

Brightspace Content  |  41

https://iweb.langara.ca/brightspace-instructor-help/interactive-resources/mini-courses/brightspace-html-templates/


Learn more about the Brightspace Accessibility 
Checker. 

Learn more about the Brightspace Editor. 

Embedding 

Embedding refers to the process of integrating external 
resources, such as videos, audio files, documents, or interactive 
elements, directly into a web page. This means students can 
watch YouTube videos, input data into a Microsoft Form, or 
contribute to a Padlet without leaving the Brightspace course 
page. 

Unlike linked content, where a user clicks on a hyperlink to 
access content in a new tab or window, embedded content 
displays as a page of the page, allowing for an integrated user 
experience. For instance, an embedded YouTube video displays 
the video player directly in a Brightspace page, allowing 
students to watch the video without leaving the course page. 

An interactive H5P element has been excluded 

from this version of the text. You can view it online 

here: 

https://pressbooks.bccampus.ca/

langaraquickguides/?p=2240#h5p-1 

Learn more about how embed Kaltura videos in Brightspace. 
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1. Create an elements 
module 

Create a new module called 
“Templates” 

2. Hide from users 

Select the Actions button 
beside the module title and 

Elements Repo 

Brightspace templates have a number of visually appealing, 
accessible, and useful elements to organize and present 
content. If using templates, it is recommended to make a 
repository to easily access the desired elements. 
To create a repository of HTML elements: 
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select Hide from Users. 

3. Create a new file 

Open the Upload / Create 
menu and select Create a File 

4. Create elements pages 

Select 

 

5. Repeat for additional 
elements. 

Create a page for images, 
accordions, and tabs 
template pages. 
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007_elements_v3 template. 

Add a title of “Elements” or 
similar. 

Copying from elements repository 

Use the following guide for best practices and tips on copying 
elements in Brightspace. 

An interactive H5P element has been excluded 

from this version of the text. You can view it online 

here: 

https://pressbooks.bccampus.ca/

langaraquickguides/?p=2240#h5p-6 
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Use caution when copying elements from your 
elements repository to your content. Selecting too 
much or too little and/or pasting over too much or 
too little can result in strange formatting. Click Undo 
on the Brightspace editor or press Control 
(Command on macOS) z to undo your most recent 
action. 

Further Resources 

Consider general course accessibility best practices to make 
your course accessible and inclusive. 

Learn more about adding and organizing Brightspace 
content. 

Preview your course content from the student’s perspective. 

Contact edtech@langara.ca for more information. 

If you are a Langara employee, self-register for Essentials 
to Excellence: A Brightspace Companion for Instructors. 
This Brightspace course compliments the technical 
instructions found here with use cases, examples, and 
advice. 
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Page Banner 

Use at the top of content 
pages. 

Images in Brightspace 

Use images in Brightspace to reinforce information, 
break up long blocks of text, create visual interest. 

Image size guidelines 

Course Banner 

Use on course homepage. 

Recommended size: 2400px wide x 960px high 

Images in Brightspace  |  47



Recommended size: 1200px 
wide x 400px high 

Instructor profile picture 

Use on Meet your instructor 
template. 

Recommended size: at least 
600px wide 

Align Full 

Use on v3 template pages. 
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Recommended size: 1200px 
wide x any dimension high 

Right and Left aligned 

Use on v3 template pages. 

Recommended size: 300px 
wide x 300px high 

Images Template 

In the Select a Document Template menu there is a template 
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title 008_images_v3. This template includes samples of images 
and instructions for adding and changing images. 

Near the bottom of the template page are options to copy 
left and right aligned images with text wrapped around as well 
as a full width image. 

1. Select template example 

In edit mode, select everything between “start copy” and “end 
copy”

2. Copy selected content and paste in your new page 

Note: the destination page must be using a template. 

3. Replace placeholder image 

1. Select placeholder image. 
2. Press Delete. 
3. Click Insert Image in toolbar. 
4. Upload image, add alt text or mark as decorative. 

Replace Images 
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1. Edit HTML 

Open the context menu beside 
the topic’s title and select Edit 

Some templates come with placeholder images. 

To replace images: 
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HTML. 

2. Delete placeholder 
image 

Select image and press Delete 
key.

After deleting the 
image do not move 
the cursor or perform 
any other actions 
except inserting your 
new image. 

3. Click Insert Image 
icon 
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4. Upload new image 

When prompted, add 
alternative text to describe 
the image, or where 
appropriate—such as images 
that do not contain 
information or are 
accompanied by an adjacent 
description—mark as 
decorative. 

Contact edtech@langara.ca for more information. 

If you are a Langara employee, self-register for Essentials 
to Excellence: A Brightspace Companion for Instructors. 
This Brightspace course compliments the technical 
instructions found here with use cases, examples, and 
advice. 
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Student View of Gradebook 

Student View of Gradebook is grading guide 1 of 
4. 

Below is what students commonly see in the Brightspace 
gradebook. 

If you were a student, how would you determine your current 
progress in the course? 

Drag the slider to the left to reveal an improved gradebook 
view. 

One or more interactive elements has been 

excluded from this version of the text. You can 

view them online here: https://pressbooks.bccampus.ca/

langaraquickguides/?p=3380 

Move to the next page to learn about using the Grades Setup 
Wizard to ensure your gradebook helps learners understand 
their progress. Consider attending Gradebook Bootcamp for 
hands-on support. 
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Grades Setup Wizard 

The Grades Setup Wizard is the first step in creating 
your gradebook and should be one of your first 
steps when setting up a Brightspace course. 
Understanding the different options in the Setup 
Wizard and how these impact student experience is 
crucial in helping students track their own progress 
through your course. 
On this page we will go through each option in each 
of the steps of the Setup Wizard and give our 
recommendations. 

Grades Setup Wizard is grading guide 2 of 4. 

Recommended Best Practice 

• Aim to set up your gradebook at the start of term 
• Use a Weighted Grading System for most courses 
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• Enable Calculated Final Grade during the term 
• Choose to automatically release final grades (available 

January 2026) 
• Configure to Treat ungraded items as 0 for calculations 
• Set final grades to automatically update 
• Enable multiple Student View Display Options for 

transparency 

The Grades Setup Wizard 

Step 1: Start the Setup Wizard 

In the My Tools menu, select Grades. If you have not accessed 
the gradebook, you will automatically be brought to the 
Grades Setup Wizard. If you have accessed the gradebook, you 
will need to go to the Setup Wizard tab. 

Scroll down and click Start. 

Step 2: Choose Grading System 

Determines how the overall grade will be tallied. In all options, 
grade items can be organized into categories and the weight 
or point value of individual items within the category can be 
distributed equally or manually. 

Weighted System: grades are calculated as a percentage 
of the final grade. In a Weighted gradebook system, the 
gradebook percentage weight must equal 100%. If it does not, 
the Manage Grades page will display an error to the instructor. 

Points System: grade items are calculated using a points 
system in which the points assigned to each item are totaled 
for the final grade. In a Points gradebook system, the sum of 
the points of the individual assessments does not have to equal 
100. 

Formula System: grade items are calculated using the points 
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systems, and a can custom defined formula can be created to 
set conditions around how grade items contribute to the final 
grade. 

Our Recommendation 
Use the Weighted Grading System because it: 

• Aligns with course syllabi – Matches the 
grade distributions commonly outlined in 
course syllabi 

• Allows for flexible weighting – Different 
types of assessments can have varying 
impacts on the final grade 

• Supports varied point values – Individual 
assessments can have different point values 
without affecting their weight 

• Enhances student transparency – Shows 
the relative importance of different 
assessments 

• Provides instructor flexibility – Makes it 
easier to modify grading structures if needed 

Step 3: Final Grade Released 

Determines which overall grade will be displayed to students 
when final grade is released to students. Note that students 
won’t see any final grade until you explicitly release it. 

Example 
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Student view of gradebook without final grade 
released 

Calculated Final Grade: the final grade is calculated based on 
the established grading formula in Step 1 and Step 3. With this 
selection the final grade is automatically calculated based on 
what is in the gradebook. You cannot adjust the final grade 
without adjusting grade item scores. If released, overall grade, 
based on the established grading formula, will be displayed 
in the student view of the gradebook. This can be set up to 
automatically update as new assessments are completed. 

Example 
Student view of grade book with Final Calculated 
Grade released 

Adjusted Final Grade: allows for manual changes to the final 
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grade calculation without affecting grade item scores. An 
Adjusted Final Grade is a final grade that you must manually 
enter to override the calculated final grade. If released, 
students will not see an overall grade in their gradebook if 
adjusted grade is not manually entered. Adjusted final grades 
do not automatically update as new assessments are 
completed. 

Example 
Student view of gradebook with Final Adjusted 
Grade released 

Automatically release final grade: If checked, allows overall 
student progress to be released. If you do not choose to 
automatically release final grades, then Final Grade needs to 
be manually released in order for students to see their overall 
progress. See instructions for releasing final grades. 

Note: As of January 2026, Automatically release final grade 
will be available. 

Our Recommendation 
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Use Calculated Final Grade during the semester as 
it automatically displays students’ overall progress, if 
released. If you need to adjust final grades at the 
end of the semester, you can switch to Adjusted 
Final Grades at that point. Remember that if 
adjusted final grades are not populated, students 
will not see their overall progress. 

Step 4: Grade Calculations 

Determines how ungraded items in your gradebook will be 
dealt with in the final grade calculations. 

Drop ungraded items: ungraded items in the gradebook are 
not taken into consideration in the Calculated Final Grade. The 
weight of each completed grade item within a category that 
contains ungraded items will be redistributed in the category 
and these items will have a greater weight than would be once 
all assessments are completed. 

Example 
If an “Exams” category worth 50% of the overall 
course grade has two midterms (worth 12.5% each) 
and a final exam worth 25% and only the midterms 
are graded, those midterms will be valued at 25% in 
the final calculated grade instead of 12.5% when 
ungraded items are dropped. Example Exams 
category with midterms weighted higher when 
ungraded items are dropped 

60  |  Grades Setup Wizard



Concerns: 

• Students cannot easily determine how the remainder of 
the assessments factor into their overall progress. 

• Unsubmitted assessments need to be manually entered 
as 0 for any ungraded items at the end of term. 

• Could result in an inaccurate snapshot of overall 
performance for the student and instructor especially if 
more heavily-weighted assessments occur later in the 
term. 

Solution: 

• Manually generate a milestone calculated grade item for 
students to see their performance. Milestone grade 
calculations do not redistribute ungraded items within a 
category and uses a reduced total to accurately represent 
student progress. See instructions on creating milestone 
grade items. 

Treat ungraded items as 0: ungraded items in the gradebook 
are taken into consideration in the Calculated Final Grade. The 
final calculated grade is additive with each entered grade 
improving the overall grade for the student. 

Example 
Example Exams category with midterms accurately 
weighted when ungraded items are treated as 0 
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Concerns: 

• Students appear to be failing the course until they have 
completed a significant number of activities in the course. 

• Any hidden grade items will also be factored into the 
calculated final grade 

Solution: 

• If calculated final grades are released to students, 
instructor should explain the gradebook structure. 

• Hidden grade items should be deleted, if not used. See 
instructions for deleting grade items. 

Automatically keep final grade updated: if checked, the Final 
Calculated Grade will be continuously updated when new 
grades are added to the gradebook allowing students to see 
their real-time progress. 

Our Recommendation 
Treat ungraded items as 0 and enable automatic 
grade updates as this provides the most accurate 
representation of student standings for both 
instructors and students regardless of whether final 
grades are released. 

Step 5: Student View Display Options 
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Determines what students are able to view in the gradebook. 
Points grade: displays the points scored for each grade item. 
Weighted grade: displays the weight of the grade item in 

relation to the calculated final grade (based on what you chose 
in Step 3) 

Grade scheme symbol: displays the symbol associated with 
the grade scheme. By default, this would be the percentage 
students score on the grade item. If you have custom grade 
schemes, this could be the letter grade associated with the 
percentage. 

Grade scheme colour: displays a specific colour associated 
with the grade scheme symbol. 

Final Grade Calculation: if checked, allows students to see 
what grade items are used in the calculation of final grade 
(calculated or adjusted). 

Example 
Image of the gradebook indicating which columns 
corresponds to which student view 

Example 
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Pop-up window displaying how grades were 
calculated 
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Our Recommendation 
Enable multiple Student View Display Options for 
transparency. 

For an immersive experience with this tool and many other 
Brightspace features, enroll in Essentials to Excellent: A 
Brightspace Companion for Instructors. This self-directed 
course offers examples, use cases, and extended information 
on how to use Brightspace to enhance the student experience. 

Now that you’ve set up your Grade Book, look at the next 
quick guide on Grades to learn about managing grades 
throughout the semester. 

Contact edtech@langara.ca for more information. 

If you are a Langara employee, self-register for Essentials 
to Excellence: A Brightspace Companion for Instructors. 
This Brightspace course compliments the technical 
instructions found here with use cases, examples, and 
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advice. 
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Grades 

The Brightspace Grades tool offers a powerful and 
flexible way to manage your grade book. It 
simplifies the grading process, enabling you to 
create and customize grade items for projects, 
assignments, discussions, and quizzes, and to 
integrate these with other Brightspace tools. 
The Grades tool allows you to set up a grading 
system that aligns with your course goals, ensuring 
effective communication of student progress and 
areas for improvement. You can customize how 
grades are displayed, updated, and managed, 
creating a seamless and efficient grading 
experience. 

Grades is grading guide 3 of 4. 

Things to consider 

Before setting up your Brightspace grade book, refer to the 
course’s Education Council approved grade allocation. Use the 
grade allocation to guide your creation of grade categories. 

Grading serves a dual purpose: providing feedback and 
evaluating student work. Through effective grading, you 
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communicate students’ performance, highlight their progress, 
and identify areas needing improvement to achieve course 
goals. In addition to marks, plan how you will provide feedback 
on graded items. Consider using rubrics, comments, and other 
feedback tools to give constructive and meaningful feedback. 

Overview of the Grades Tool 

The Brightspace Grades tool offers a robust suite of features 
designed to create and manage grades. With its flexible and 
powerful capabilities, Brightspace reduces technical barriers 
and empowers you to teach and assess in a way that aligns 
with your course learning outcomes. 

One or more interactive elements has been 

excluded from this version of the text. You can 

view them online here: https://pressbooks.bccampus.ca/

langaraquickguides/?p=1452#oembed-1 

Setting Up Your Brightspace 
Gradebook for Student Success 

A well-structured gradebook helps students track their 
progress and understand how individual assessments 
contribute to their overall grade. To ensure transparency, 
students should have access to their overall progress at various 
points throughout the term (e.g., before the withdrawal 
deadline, after substantial assessments, etc.). 
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In Brightspace, you can display overall progress in two ways: 

Release Final Calculated Grade 
This option displays overall progress to students which 
automatically updates as students complete assessments 
throughout the term. 

Pros: provides real-time view of overall progress when 
released. 

Cons: requires ungraded items to be treated as 0* in order 
for accurate display of overall progress. This means overall 
grade is additive as assessments are completed. Students 
will need a clear explanation on the gradebook set up. 

Milestone Grade Calculations 
This approach requires you to manually set up grade 
calculations at key points in the term, helping students 
understand their performance at designated checkpoints. 

Pros: allows ungraded items to be dropped* so it will 
display student progress in relation to the number of 
assessments completed. 

Cons: each milestone grade calculation needs to be 
manually set up. 

*Refer to cautionary notes regarding Grade Calculations 

Essential Steps to Setting Up Your 
Grade Book 

Before you Begin 
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Have your course syllabus, assessment list, and 
grading structure ready. Plan to set up your complete 
gradebook at the start of term to ensure accurate grade 
calculations for students. If assessment items are 
missing, students may see misleading calculations of 
their overall progress—grades may appear artificially 
higher, lower, or incomplete depending on the settings 
used. This can lead to student confusion about their 
actual standing in the course. 

1. Complete the Grades Setup Wizard. 
2. Create grades categories. 
3. Create grade items. 
4. Associate activities with grade items. 

Complete the Setup Wizard 
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You can configure the setup of your gradebook by clicking My 
Tools > Grades. 

The Setup Wizard is the first 
step in creating your gradebook. 
If this is your first-time accessing 
Grades in your sandbox or 
course, you will automatically be 
directed to the seven-step Setup 
Wizard. You can return to the 
Setup Wizard at any time 
through the Setup Wizard tab. 
Under the Setup Wizard tab, 
scroll down and click Start to 
begin setup. 

The Setup Wizard allows you 
to: 

• Establish a grading system 
• Determine your final 

calculation method 
• Identify what to do with 

ungraded items 
• Choose grade scheme 
• Set Display settings 

Read through the Understanding the Grades Setup Wizard 
page for our recommended settings and additional 

Grades  |  71



information on how each option impacts the student 
experience. 
To set up your gradebook and release final calculated grade: 

1. In the Grades Setup Wizard, choose: 

◦ Weighted grading system 
◦ Release Calculated Final Grade 
◦ Treat ungraded items as 0 and automatically keep 

final grade updated 

2. Follow instructions to manually release Final Calculated 
Grades. 

To set up your gradebook and create milestone grade items: 

1. In the Grade Setup Wizard, choose: 

◦ Weighted grading system 
◦ Release Adjusted Final Grade 
◦ Automatically keep final grade updated 

2. Follow instructions to manually create milestone grade 
items at specific intervals throughout your course. 

Gradebook Categories and Items 

Under the Manage Grades tab, you can create Grade Book 
Categories and Items. 

Using Categories in your grade book allows you to organize 
your items under category headings. For example, you can 
create category headings to organize Assignments, Quizzes, 
Case Studies, Participation, and Discussions. 

A category can consist of one or more grade items. When 
graded items are grouped together in a category, you can 
distribute the category weight equally across all grade items 

72  |  Grades

https://iweb.langara.ca/brightspace-instructor-help/my-tools/grades/releasing-final-grades-to-students/#aioseo-how-to-release-the-final-calculated-grade-instead
https://iweb.langara.ca/brightspace-instructor-help/my-tools/grades/releasing-final-grades-to-students/#aioseo-how-to-release-the-final-calculated-grade-instead
https://iweb.langara.ca/brightspace-instructor-help/my-tools/grades/grades-settings/milestone-grade/
https://iweb.langara.ca/brightspace-instructor-help/my-tools/grades/grades-settings/milestone-grade/


and drop the highest or lowest item in the group. If you decide 
to manually distribute the category weight toward each grade 
item, you will need to determine the portion of the category 
grade that will go towards each item. Use the formula below to 
help you determine this: 

grade item weightgrade category weight×100 
Example 
If a grade item is worth 5% of the 
overall course grade and the 
category weight is 20% of the overall 
grade, the manually weighted item is 
worth: 

5/20 x 100 = 25% of the category weight 
For a weighted grade book system, categories are required 

and used to identify weighted areas. 
To create grade categories: 

From the Manage Grades tab, 

1. Click on New and select Category. 
2. Give your category a name and select the options that are 

relevant for the category. 
3. Click Save and Close. 

Watch the following video to learn how to create grade 
categories. 

One or more interactive elements has been 

excluded from this version of the text. You can 

view them online here: https://pressbooks.bccampus.ca/

langaraquickguides/?p=1452#oembed-2 
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Warning: Do not create a category to organize 
bonus items. Brightspace calculates subtotals for 
categories, in the case of a bonus item category the 
subtotal denominator would be 0 and division by 0 
is an arbitrary math violation. 
See EdTech’s Bonus Marks resource to learn how to 
assign bonus marks and create a bonus grade item. 

To create grade items: 

From the Manage Grades tab, 

1. Click on New and select Category. 
2. On the New Item page, choose a Grade Item Type from 

the following: 

◦ Numeric: Grade users by assigning a value out of a 
specified total number of points. 

◦ Selectbox: Grade users by selecting the grade scheme 
level that best matches their achievement. Selectbox 
type grade items cannot be created until at least one 
org unit grade scheme has been created. 
Note: Numeric and Selectbox are the only grade items 
that will support associations for grading and actively 
contribute to grade book calculations. 

◦ Pass/Fail: Grade users using a simple pass or fail grade 
scheme. 

◦ Formula: Automatically grade users using a custom 
formula based on their achievement for other grade 
items. 

◦ Calculated: Calculate users’ cumulative achievement 
across multiple grade items. 

◦ Text: Provide comments in the grade book that are 
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not calculated in the final grade. 

3. In the Properties tab, enter the details for your grade item. 
Note: The fields in Properties will vary based on your 
chosen Grade Item Type. To learn more about a particular 
field in Properties, click the Get help on (? icon) beside the 
field. 

4. In the Restrictions tab, enter the following information: 

◦ Hide from users: Hide restrictions from learners. 
◦ Has Start Date: Set a Start Date for the grade 

category. 
◦ Has End Date: Set an End Date for the grade category. 
◦ Display In Calendar: Display Start and End Dates in 

the course Calendar. 
◦ Release Conditions: You can Attach 

Existing conditions or Create and Attach conditions. 

5. Click Save and Close. 

One or more interactive elements has been 

excluded from this version of the text. You can 

view them online here: https://pressbooks.bccampus.ca/

langaraquickguides/?p=1452#oembed-3 

Associate Activities with Grade 
Items 

The final stage in setting up your grade book and having it 
populate with student marks is to associate graded activities 
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with the grade items in your grade book. The following videos 
shows you how its done. 

One or more interactive elements has been 

excluded from this version of the text. You can 

view them online here: https://pressbooks.bccampus.ca/

langaraquickguides/?p=1452#oembed-4 

More About Grades 

Learn how to 

• Adjust and release final grades 
• Drop lowest item score from a grade category 
• Add bonus grades 
• Delete a grade item and grade category 

Next Steps 

• Enter and preview grades 
• Grade assignments and provide feedback 
• Grade quizzes 
• Adjust final grades 
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Now that you’ve setup your grade book check out how to add 
bonus grades. 

Contact edtech@langara.ca for more information. 

If you are a Langara employee, self-register for Essentials 
to Excellence: A Brightspace Companion for Instructors. 
This Brightspace course compliments the technical 
instructions found here with use cases, examples, and 
advice. 
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Adding Bonus Grades 

In certain instances, you might want to award 
bonus marks to students for an assessment or make 
an entire activity a bonus item in the grade book. 
These situations can be accommodated in 
Brightspace. 

Adding Bonus Grades is grading guide 4 of 4. 

Enable Bonus Marks for a Grade 
Item 

In the instance where you would like students to be able to 
exceed the maximum number of points on an assessment like 
an assignment or quiz, you will need to ensure you check off 
Can Exceed for the grade book grade item. 

Step 1: Go to My Tools > Grades > Manage Grades. 

• If you have created this grade item already, click the caret 
next to the grade item you want to exceed 100% and select 
Edit. 

• If you have not created the grade item yet, select New > 
Item. 
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Step 2: Under the Grading section, select the Can Exceed 
checkbox. 

Step 3: Click Save and Close. 

Create a Bonus Grade Item 

In the instance where you want to create a bonus item that 
does not impact the Final Calculated Grade if students choose 
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not to complete the item, you will need to ensure you check off 
Bonus for the grade item. 

Step 1: Go to My Tools > Grades > Manage Grades 

• If you have created this grade item already, click the caret 
next to the grade item you want to exceed 100% and select 
Edit. 

• If you have not created the grade item yet, select New > 
Item. 

Step 2: Under the Grading section, select the 
Bonus checkbox. 
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Step 3: Click Save and Close. 

On the Manage Grades, you will see a star beside your grade 
item, indicating that this item is bonus. 

Important 
Bonus items are not included in the maximum 
points for a category or final grade. They are added 
on top of the calculated grade. If the bonus grade 
item is within a category and you want the category 
to exceed 100%, see Enable a Grade category to 
Exceed 100% below. If you want the bonus grade 
item to allow the final calculated to exceed 100%, 
see Enable Final Grade to Exceed 100%. 

Enable Category to Exceed 100% 

In the instance where you have awarded bonus marks to a 
grade item or made a bonus grade item and want the category 
that the item is in to exceed the the maximum category 
weight, you need to ensure you check off Allow category grade 
to exceed category weight. 

Step 1: Go to My Tools > Grades > Manage Grades. 

• If you have created the Category, click the caret next to the 
Category you want to exceed 100% and select Edit. 
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• If you have not created the grade item yet, select New > 
Category. 

Step 2: Under the Grading section, select the Allow 
category grade to exceed category weight checkbox. 

Step 3: Click Save and Close. 

Enable the Final Calculated Grade 
to Exceed 100% 

In the instance where you would like the final calculated grade 
to exceed 100%, you need to ensure you check off the Can 
Exceed box in the Final Calculated Grade. 

Step 1: Go to My Tools > Grades > Manage Grades. 

Step 2: Click the caret next to Final Calculated Grade and 
select Edit. 
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Step 3: Under Grading, select Can Exceed. 

Step 4: Click Save and Close. 

Contact edtech@langara.ca for more information. 
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If you are a Langara employee, self-register for Essentials 
to Excellence: A Brightspace Companion for Instructors. 
This Brightspace course compliments the technical 
instructions found here with use cases, examples, and 
advice. 
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Assignments 

The Brightspace Assignments tool allows you to 
create assignment submission folders, set 
submission requirements, attach rubrics, and 
provide feedback to students. Using assignment 
folders creates a clear record of submissions, 
enables efficient grading workflows, and keeps 
student work organized in one secure location. 

Assignments is Assignments guide 1 of 2. 

Recommended Best Practices 

• Create assignments directly in Content so they appear in 
your course modules 

• Link assignments to gradebook items before the term 
starts 

• Use File submission for most written work requiring file 
uploads 

Assignments  |  85



• Use On paper submission or Observed in person when 
appropriate to maintain gradebook organization even for 
non-digital work 

• Attach rubrics to clarify grading criteria and streamline 
assessment 

• Write clear, detailed instructions that include submission 
requirements and grading expectations 

• Set due dates to add assignments to the course calendar 

Before You Begin 

Consider preparing: 

• Rubric: Create your rubric before setting up the 
assignment so you can attach it immediately 

• Gradebook structure: Set up your gradebook before 
creating assignments to link them to existing grade items 
and categories 

• Assignment instructions: Draft clear, detailed instructions 
including purpose, requirements, and submission details 

• Groups (for group assignments): Form your groups in 
Brightspace before creating group assignments 

Creating an Assignment 

Our Recommendation 
Create assignments directly in Content so they 
appear in your course modules. If you create 
assignments via the Tools menu, students can only 
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access them through the Tools menu unless you 
manually add them to your modules. 

Step-by-step instructions 

Step 1: Navigate to Assignment Location 

1. Go to Course Materials > Content 
2. Select the module where you want to add the assignment 
3. Click Upload/Create > New Assignment 

Step 2: Enter Assignment Details 

1. Title: Give the assignment a descriptive name 
2. Instructions: Add detailed assignment instructions in the 

description field. Include: 

◦ Purpose and connection to learning outcomes 
◦ Step-by-step instructions with specific submission 

requirements 
◦ Grading criteria or reference to attached rubric 
◦ How and when students will receive feedback 

Step 3: Configure Grade Settings 

1. In the Grade Out Of box, set the point value 
2. Use the In Grades dropdown to: 

◦ Create a new gradebook item (default) 
◦ Link to an existing gradebook item (select Edit or Link 

to Existing) 
◦ Select a grade category if you’ve set them up 

Step 4: Set Dates 
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1. Due Date: Set the deadline for submission 

◦ Due dates automatically appear in the course calendar 
◦ Students can submit after the due date but 

submissions are marked as late 

2. Availability Dates: (Optional) Set when the assignment 
becomes available and when it closes 

◦ Use for time-restricted assignments 
◦ End dates override due dates 

See also Dates, Deadlines, and Availability Quick Guide 

Step 5: Configure Submission Settings (Submissions & 
Completion) 

1. Assignment Type: Choose Individual or Group 
Assignment 

◦ Individual assignments: Each student submits 
separately 

◦ Group assignments: One submission per group 
(requires groups to be set up first) 

◦ Note: This setting cannot be changed after students 
submit 

2. Submission Type: Select how students will submit (see 
detailed options below) 

3. Number of Submissions: Decide how many attempts 
students are allowed 

4. Category: (Optional) Choose a category to organize 
assignments by type or topic 

Step 6: Add Rubric and Evaluation Settings (Evaluation & 
Feedback) 

1. Rubric: Click Add Rubric and select from your existing 
rubrics 

88  |  Assignments



2. Anonymous Marking: Check this option if you want to 
hide student names during grading (see guidance below) 

3. Annotation Tools: Leave enabled to provide inline 
feedback on submissions 

Step 7: Save 

1. Click Save and Close 
2. The assignment now appears in your module and is linked 

to your gradebook 

Watch this video to see how Assignment Submission folders 
are created: 

One or more interactive elements has been 

excluded from this version of the text. You can 

view them online here: https://pressbooks.bccampus.ca/

langaraquickguides/?p=3274#oembed-1 

Key Assignment Options 

Submission Types: Choosing the Right Option 

File submission (default): Students upload documents, 
images, or other files 

• Best for: Essays, projects, reports, portfolios – any work 
requiring file uploads 

• Options: You can restrict file types (e.g., PDF only, 
annotatable files only) or allow all file types 

• Number of files: Set how many files students can submit 
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per submission 

Text submission: Students write directly in Brightspace using 
the text editor 

• Best for: Shorter written responses, reflections, 
discussion-style assignments 

• Benefit: Ensures text accessibility and keeps work within 
Brightspace 

File or text submission: Students choose to upload a file OR 
write in the text box 

• Best for: Assignments where you want to give students 
flexibility in how they submit 

• Example: Students can upload a Word doc, paste a link to 
an external file, or type directly into Brightspace 

On paper submission: Students submit physical work in class 

• Best for: Paper-based assignments where you still want 
gradebook integration 

• Benefit: Maintains consistency in your course structure – 
students see the assignment in Brightspace, know it’s part 
of their grade, and you can provide feedback through 
Brightspace even though they submitted on paper 

• Note: Students cannot submit anything digitally, but you 
can upload scanned copies when providing feedback 

Observed in person: Students complete presentations, 
demonstrations, or performances 

• Best for: Presentations, oral exams, demonstrations, 
performances 

• Benefit: The assignment folder links to your gradebook 
and provides a place to record feedback without requiring 
file submission 
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Our Recommendation 
Use File submission for most written work. Consider 
On paper submission or Observed in person even 
for non-digital work to maintain gradebook 
organization and provide consistent feedback 
through Brightspace. This creates a better student 
experience – they see all their assignments in one 
place regardless of submission method. 

Anonymous Marking: When to Use It 

Anonymous marking hides student names during grading to 
reduce unconscious bias and increase students’ confidence in 
grading fairness. 

When to use anonymous marking: 

• High-stakes assignments where bias concerns are 
significant 

• Assignments where student identity might influence 
grading (creative writing, opinion pieces) 

• When you want to focus purely on the quality of work 

Important considerations: 

• Cannot be disabled once students have submitted 
• Must publish all feedback at once using “Publish All 

Feedback” – cannot publish individual grades 
• Students see “Anonymous User 1,” “Anonymous User 2,” 

etc. during grading 
• If students include their names in the document itself, 

anonymity is compromised 
• Let students know anonymous marking is being used and 

remind them not to include their name in the submission 
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Our Recommendation 
Use anonymous marking thoughtfully. While it 
reduces bias, it also requires publishing all feedback 
simultaneously which can be cumbersome. Reserve 
it for assignments where bias concerns are most 
significant. For most routine assignments, rubrics 
provide sufficient grading consistency without the 
constraints of anonymous marking. 

Learn more about anonymous marking 
Restricting File Types 

Under Submissions & Completion, you can restrict which file 
types students can upload: 

Options: 

• Any file type: Students can upload any file format 
• Annotatable files: Only files that work with Brightspace 

annotation tools (PDF, Word, PowerPoint, images) 
• Document files: Word, PDF, text files only 
• Presentation files: PowerPoint, PDF only 
• Custom file extensions: Specify exactly which extensions 

are allowed (e.g., .pdf, .docx) 

Our Recommendation 
For written assignments where you’ll provide inline 
feedback, restrict to Annotatable files. This ensures 
you can use Brightspace’s annotation tools to mark 
directly on student submissions. For other 
assignments, consider whether restriction is 
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necessary – sometimes flexibility in file format 
reduces student frustration without impacting your 
grading. 

Number of Submissions Allowed 

Under Submissions & Completion, decide how many times 
students can submit: 

Unlimited attempts: Students can resubmit as many times 
as they want before the deadline 

• Best for: Lower-stakes assignments, drafts, iterative work 
• Benefit: Students can correct mistakes or improve their 

work 
• Note: You choose whether to keep all submissions or only 

the final one 

One attempt only: Students can only submit once 

• Best for: High-stakes assignments, exams, final 
submissions 

• Benefit: Prevents last-minute resubmissions after seeing 
initial feedback 

Specific number: Set exactly how many submissions are 
allowed (e.g., 2 attempts) 

• Best for: Assignments with a draft and final version 

Our Recommendation 
For major assignments, use one attempt to 
maintain academic integrity. For lower-stakes work 
or when you want to encourage revision, allow 
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unlimited attempts and keep only the final 
submission to reduce grading load. 

Writing Clear Assignment 
Instructions 

Students can’t ask immediate follow-up questions like they 
might in class, so clear written instructions are essential. 

Your assignment instructions should include: 

• Due date and any key milestones: Even though it’s in the 
assignment settings, repeat it in instructions 

• Purpose: Explain the assignment’s connection to course 
learning outcomes 

• Step-by-step instructions: Break down exactly what 
students need to do 

• Submission requirements: What format, how many files, 
what to name files, etc. 

• Grading criteria: Include or reference your rubric, explain 
what you’re looking for 

• Feedback timeline: When and how students will receive 
feedback 

Learn more about writing clear assignment instructions 

Advanced Features 

Special Access 

Provide deadline extensions or modified requirements for 
specific students or groups who need accommodations. 
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Common uses: 

• Extended deadlines for students with accommodations 
• Different due dates for different sections 
• Additional attempts for specific students 

Special Access is configured in the assignment settings and 
overrides the default settings for selected students. 
Release Conditions 

Control when students can access assignments based on dates 
or completion of prerequisite activities. 

Example uses: 

• Assignment only becomes visible after completing a quiz 
• Sequential assignments that unlock as previous ones are 

completed 
• Content restricted until a specific date 

Further Resources 

• Evaluate assignments and provide feedback 
• Support student audio and video submissions 
• Preview assignments as a student 
• Creating rubrics in Brightspace 

Now that you’ve setup some assignments, learn about 
grading assignments on the next page. 
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Contact edtech@langara.ca for more information. 

If you are a Langara employee, self-register for Essentials 
to Excellence: A Brightspace Companion for Instructors. 
This Brightspace course compliments the technical 
instructions found here with use cases, examples, and 
advice. 
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Grading Assignments in Brightspace 

Brightspace provides multiple options for grading 
assignments and providing feedback to students. 
You can use rubrics for consistent evaluation, 
annotation tools for inline feedback, and various 
feedback methods including text, audio, and video. 
This guide covers grading workflows for both 
individual and group assignments. 

Grading Assignments in Brightspace is 
Assignments guide 2 of 2. 

Recommended Best Practices 

• Use rubrics for consistent, efficient grading and clear 
expectations 

• Enable annotation tools when creating assignments to 
provide inline feedback 

• Save grades as drafts to review before publishing if you’re 
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unsure 
• For group assignments, grade through the Assignments 

tool to give all members the same grade automatically 
• Use the navigation arrows to move between submissions 

efficiently 
• Provide meaningful, constructive feedback that helps 

students improve 
• Publish feedback promptly so students can learn from it 

Accessing Assignments for 
Grading 

To access student submissions: 

1. Go to Tools > Assignments (or access from Content if you 
created the assignment there) 

2. Click on the assignment name 
3. You’ll see a list of submissions with submission status and 

dates 
4. Click on a student’s name or submitted file to begin 

grading 

Grading Individual Assignments 

Step-by-step grading process 

Step 1: Open the Submission 

1. Navigate to Tools > Assignments 
2. Click on the assignment you want to grade 
3. Click on a student’s name or their submitted file 
4. The grading interface opens with the submission on the 
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left and feedback panel on the right 

Step 2: Review the Submission 

• The student’s submitted file appears on the left side of the 
screen 

• If they submitted multiple times, all submissions appear in 
a dropdown menu (most recent submission is displayed 
first) 

• For text submissions, the text appears directly on the page 

Step 3: Enter Grade and Feedback 

On the right side of the screen: 

1. Overall Grade: Enter the score (this automatically syncs to 
the gradebook) 

2. Rubric (if attached): Click rubric levels to calculate the 
grade automatically 

3. Overall Feedback: Type feedback in the text box 

◦ Format text, add images, or use “Insert Stuff” to add 
links or videos 

◦ This feedback is visible to students in both 
Assignments and Grades 

4. Feedback Files (optional): Upload files such as: 

◦ Annotated copies of student work 
◦ Instructor notes or additional resources 

5. Audio/Video Feedback (optional): Click the microphone 
or camera icon 

◦ Record up to 1 minute of audio or 3 minutes of video in 
Brightspace 

◦ Or upload larger pre-recorded files (up to 1 GB) 
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Step 4: Provide Inline Feedback 

1. Click the pen icon in the document viewer toolbar 
2. Use annotation tools to: 

◦ Highlight text 
◦ Add text comments directly on the document 
◦ Insert notes (appears as icons students can click to 

expand) 
◦ Draw or mark up the submission 

3. Annotations appear directly on the student’s submission 
and are visible when they view feedback 

Step 5: Publish or Save as Draft 

• Publish: Immediately releases the grade and feedback to 
the student (syncs to gradebook and sends notification) 

• Save Draft: Saves your work without releasing it to 
students (use this if you want to review grades before 
publishing) 

Step 6: Navigate to Next Submission 

• Use the navigation arrows in the top-right or bottom-right 
corners to move to the next student 

• This allows you to grade continuously without returning to 
the submission list 

Watch this video to see the grading process: 

One or more interactive elements has been 

excluded from this version of the text. You can 
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view them online here: https://pressbooks.bccampus.ca/

langaraquickguides/?p=3289#oembed-1 

Grading Group Assignments 

Grading all group members together 

When to use this approach: When all group members 
contributed equally and deserve the same grade. 

Step 1: Grade Through Assignments Tool 

1. Navigate to Tools > Assignments 
2. Click on the group assignment 
3. You’ll see group names instead of individual student 

names 
4. Click on a group’s submission to open it 

Step 2: Enter Grade and Feedback 

1. Grade the submission as you would an individual 
assignment 

2. Enter the overall grade 
3. Provide feedback (text, rubric, audio/video, or inline 

annotations) 
4. Click Publish 

Result 

• All group members automatically receive the same grade 
• All group members see the same feedback 
• The grade appears in each student’s individual gradebook 
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Giving different grades to individual group members 

When to use this approach: When group members 
contributed unequally or individual performance varied. 

Important Note 
You must first grade the group through the 
Assignments tool to give everyone the baseline 
grade. Then adjust individual grades in the 
Gradebook. If you only enter grades in the 
Gradebook, students won’t see the grade in the 
Assignments tool. 

Step 1: Grade the Group 

1. Follow the steps above to grade the group assignment in 
the Assignments tool 

2. Enter the grade that most group members earned 
3. Publish this grade 

Step 2: Adjust Individual Grades in Gradebook 

1. Navigate to Tools > Grades 
2. Find the group assignment grade column 
3. Click the dropdown arrow next to the grade item name 
4. Select Enter Grades 
5. Change the grade for specific students who deserve 

different grades 
6. Optionally, add individual feedback in the Feedback 

column 
7. Click Save and Close 
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Student View 

Important consideration: Students whose grades were 
adjusted will see two different grades: 

• The original group grade in the Assignments tool 
• Their individual adjusted grade in the Gradebook 

Communication tip: Let students know upfront that: 

• They should check the Gradebook for their official grade 
• The grade in Assignments reflects the group’s overall 

performance 
• Their Gradebook shows any individual adjustments 

Key Grading Options 

Grading with Rubrics 

Benefits of using rubrics: 

• Faster grading – click rubric levels instead of writing 
individual feedback for each criterion 

• More consistent grading across students 
• Clearer expectations for students 
• Automatic grade calculation 

How to grade with a rubric: 

1. When grading a submission, the rubric appears on the 
right side of the screen 

2. Click the appropriate level for each criterion 
3. The total score calculates automatically 
4. Add additional overall feedback if needed 
5. Publish feedback 

See the Rubrics Quick Guide for creating and using rubrics. 
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Our Recommendation 
Use rubrics for major assignments to ensure 
consistency and efficiency. Even brief rubrics (3-4 
criteria with 3-4 levels) dramatically speed up 
grading while improving feedback quality. 

Using Annotation Tools for Inline Feedback 

What are annotation tools? Built-in Brightspace tools that let 
you mark directly on student submissions – like grading a 
paper assignment but digitally. 

Supported file types: 

• PDF 
• Microsoft Word (DOC, DOCX) 
• Microsoft PowerPoint (PPT, PPTX) 
• Images (JPG, PNG, etc.) 

Available annotation tools: 

• Highlight: Mark important passages in different colors 
• Text: Add text comments directly on the document 
• Notes: Insert note icons students can click to read longer 

feedback 
• Free draw: Circle, underline, or draw arrows 
• Shapes: Add rectangles, lines, etc. 

How students see inline feedback: 

• Annotations appear directly on their submitted document 
• Students access inline feedback by clicking “View Inline 

Feedback” in the Assignments tool 
• Annotations also appear when they view the feedback in 

the Grades tool 
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Our Recommendation 
Enable annotation tools when creating assignments 
that require detailed feedback on written work. 
Combine inline annotations (specific feedback on 
content) with overall feedback (summary 
comments and guidance for improvement) for the 
most effective student learning experience. 

Important note: If you use Turnitin for an assignment, don’t 
use Brightspace annotation tools on the same assignment – 
students can’t see both sets of annotations together. Choose 
one feedback method or the other. 
Audio and Video Feedback 

Why use audio/video feedback? 

• Conveys tone and emotion better than text 
• More personal connection with students 
• Can explain complex feedback more clearly 
• Often faster than typing extensive written feedback 

How to record feedback: 

1. When grading, click the microphone icon (audio) or 
camera icon (video) 

2. Choose Record Audio/Video or Upload File 
3. If recording in Brightspace: record up to 1 minute (audio) 

or 3 minutes (video) 
4. If uploading: files can be up to 1 GB 
5. Add a title and description 
6. Click Add and Update 

Student access: Students can open and download audio/video 
files from both the Assignments tool and their Gradebook. 
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Our Recommendation 
Use audio/video feedback strategically – it works 
especially well for major assignments, complex 
feedback, or when students need extra 
encouragement. For routine assignments with 
rubrics, text feedback may be more efficient. 
Consider recording a brief video walking through 
the rubric for students who struggled significantly. 

Publishing Feedback: Immediately vs Draft 

Publish immediately when: 

• You’re confident in the grade and feedback 
• You want students to receive feedback quickly 
• You’re using a rubric that provides clear, objective grading 

Save as draft when: 

• You want to review all grades before releasing them 
• You need to check your grading consistency across 

students 
• You’re grading complex assignments and want to step 

away and return with fresh eyes 
• You’re using anonymous marking (you must save all as 

drafts and publish all at once) 

Publishing all drafts at once: 

1. Return to the assignment submission list 
2. Select the checkboxes next to students whose drafts you 

want to publish 
3. Click Publish Feedback 
4. Confirm in the popup window 
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Our Recommendation 
For major assignments, save the first few as drafts to 
establish your grading standards, review for 
consistency, then publish when confident. For 
routine assignments with clear rubrics, publishing 
immediately is fine. 

Grading Efficiency Strategies 

Grading multiple submissions efficiently 

Use navigation arrows: 

• Grade one submission, then use arrows (top-right or 
bottom-right) to move to the next 

• No need to return to the submission list between students 

Grade in batches: 

• Set dedicated grading time rather than grading 
sporadically 

• Grade similar work together to maintain consistency 

Create a feedback bank: 

• Keep a document of common feedback phrases 
• Copy and paste, then personalize for each student 

Maximize rubrics: 

• Let the rubric do most of the talking 
• Add brief overall feedback to personalize or highlight key 

points 
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Common Issues and Solutions 

Student says they can’t see their feedback 

Check: 

• Did you click “Publish” instead of “Save Draft”? 
• Is the assignment visible to students? 
• For anonymous marking: Did you publish all feedback at 

once using “Publish All Feedback”? 

Grade doesn’t appear in gradebook 

Make sure: 

• The assignment is linked to a gradebook item 
• You clicked “Publish” (not just “Save Draft”) 
• The gradebook item is visible to students 

Annotations aren’t showing for students 

• Annotations only work on supported file types (PDF, Word, 
PowerPoint, images) 

• Make sure you enabled annotation tools when creating 
the assignment 

• Verify you published the feedback (annotations don’t 
appear in draft mode) 

• If using Turnitin, students must view feedback in Turnitin’s 
GradeMark – Brightspace annotations won’t appear there 

Further Resources 

• Evaluate assignments (D2L documentation) 
• Creating rubrics in Brightspace 
• Creating assignment submission folders 
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Contact edtech@langara.ca for more information. 

If you are a Langara employee, self-register for Essentials 
to Excellence: A Brightspace Companion for Instructors. 
This Brightspace course compliments the technical 
instructions found here with use cases, examples, and 
advice. 
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Quizzes — Using the Question Library 

The Question Library is a central repository for 
storing and organizing quiz questions that you can 
reuse across multiple quizzes, surveys, and 
self-assessments. Think of it as your personal 
question bank where you can create sections 
(folders) to organize questions by topic, chapter, or 
type, making them easy to locate when building 
assessments. 

Quizzes — Using the Question Library is Quizzes 
guide 1 of 3. 

Recommended Best Practices 

• Always create questions in the Question Library first – 
questions created directly in quizzes are not automatically 
saved to the library 

• Organize questions in sections (folders) before creating 
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them – makes importing into quizzes seamless 
• Use descriptive section names that match your course 

structure (e.g., “Chapter 3: Cell Biology” or “Midterm – Unit 
1”) 

• Import questions from existing quizzes to the Question 
Library as backup in case quizzes are deleted 

• Create the Question Library structure at the start of term, 
even if you haven’t written all questions yet 

Why Use the Question Library? 

Watch this video for an overview of the benefits: 

One or more interactive elements has been 

excluded from this version of the text. You can 

view them online here: https://pressbooks.bccampus.ca/

langaraquickguides/?p=3295#oembed-1 

Key benefits: 

• Reusability: Use the same questions across multiple 
quizzes, surveys, or self-assessments 

• Organization: Keep questions organized by topic, 
difficulty, or type 

• Backup: Questions stored in the library are preserved even 
if quizzes are deleted 

• Efficiency: Update a question once in the library and it 
updates everywhere it’s used 

• Easy import: Import entire sections into quizzes rather 
than adding questions one-by-one 

• Version control: Create multiple versions of similar 
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questions for randomization 

Accessing the Question Library 

1. Go to Tools > Quizzes 
2. Click the Question Library tab 

Setting Up Your Question Library 

Step 1: Create sections to organize questions 

What are sections? Sections are folders that help you organize 
questions. You can create sections and subsections (folders 
within folders) to match your course structure. 

Common organizational strategies: 

• By chapter or unit: “Chapter 1,” “Chapter 2,” etc. 
• By topic: “Newton’s Laws,” “Friction,” “Spring Forces” 
• By assessment: “Midterm,” “Final Exam,” “Weekly Quizzes” 
• By question type: “Multiple Choice,” “Short Answer,” 
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“Calculations” 
• By difficulty: “Easy,” “Medium,” “Hard” 

Our RecommendationOrganize by topic or 
learning outcome rather than by assessment type. 
This makes questions easier to find when creating 
different quizzes. For example, “Chapter 3: 
Photosynthesis” is more useful than “Quiz 2 
Questions” because you might want to pull 
photosynthesis questions for multiple assessments. 

To create a section: 
Watch this video: 

One or more interactive elements has been 

excluded from this version of the text. You can 

view them online here: https://pressbooks.bccampus.ca/

langaraquickguides/?p=3295#oembed-2 

Or follow these steps: 

1. In the Question Library, click New > Section 
2. Enter a Section Name (this helps you identify the folder) 
3. Optional settings: 

◦ Message: Add introductory text that appears when 
this section is imported into a quiz 

◦ Display options: Choose whether to show the 
message at the beginning of the section or before 
each question 

◦ Add image: Include an image that appears with the 
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section 
◦ Private comments: Add notes for your own reference 

(students never see these) 

4. Click Save 

To create subsections (folders within folders): 

1. Click on the parent section name to open it 
2. Click New > Section 
3. Follow the same steps as above 

Step 2: Create questions in sections 

Creating New Questions 

1. Click on the section name where you want to add 
questions 

2. Click New and select a question type from the dropdown 
3. Fill in the question details 
4. Click Save 

Watch this video for an overview of available question types: 

One or more interactive elements has been 

excluded from this version of the text. You can 

view them online here: https://pressbooks.bccampus.ca/

langaraquickguides/?p=3295#oembed-3 

Available question types: 

• True/False (T/F): Two-option questions 
• Multiple Choice (MC): One correct answer from multiple 

options 
• Multi-Select (MS): Multiple correct answers possible 
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• Written Response (WR): Long-answer questions requiring 
manual grading 

• Short Answer (SA): Brief text responses 
• Fill in the Blanks (FIB): Complete missing words or 

phrases 
• Matching (M): Connect items in two columns 
• Ordering (ORD): Arrange items in correct sequence 
• Arithmetic (A): Math calculations with automatic grading 
• Significant Figures (SF): Math with precision 

requirements 
• Likert (LIK): Scale-based responses (for surveys) 

For detailed instructions on creating each question type, see 
D2L’s guide to creating questions. 

For pedagogical guidance on choosing question types, see 
Memorial University’s resource on Question Types. 

Our RecommendationUse auto-graded question 
types (Multiple Choice, True/False, Multi-Select, Fill 
in the Blanks) whenever possible to reduce grading 
load. Reserve Written Response and Short Answer 
for assessments where you specifically need to 
evaluate written communication or complex 
thinking that can’t be captured through 
selected-response questions. 

Step 3: Import questions from existing quizzes (if applicable) 

Why import questions from quizzes? Questions created 
directly in quizzes are NOT automatically saved to the Question 
Library. Import them to create a backup and enable reuse. 

To import questions from an existing quiz: 
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1. In the Question Library, click on the section where you 
want to store the questions 

2. Click Import > Browse Existing Questions 
3. Change the Source dropdown to the quiz containing the 

questions you want 
4. Check the boxes next to questions or sections you want to 

import (or check the top box to select all) 
5. Click Import 
6. Repeat for other quizzes as needed 
7. Click Done Editing Questions when finished 

Important Note 

The Question Library stores questions separately from quizzes. 
If you delete a quiz, the questions in it are also deleted UNLESS 
you’ve imported them to the Question Library. Make it a habit 
to import quiz questions to the library as backup. 
Importing questions from another course 

To import questions from another course’s Question Library: 
Watch this video: 

One or more interactive elements has been 

excluded from this version of the text. You can 

view them online here: https://pressbooks.bccampus.ca/

langaraquickguides/?p=3295#oembed-4 
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Brief steps: 

1. Go to Course Admin > Import/Export/Copy Components 
2. Select Copy Components from Another Course 
3. Choose the source course 
4. Select Question Library 
5. Choose which sections to import 
6. Complete the import 

This is useful when teaching the same course in multiple terms 
or sharing questions with colleagues. 

Question Library Organization Tips 

Managing and moving questions 

To move questions between sections: 

1. In the Question Library, check the boxes next to questions 
you want to move 

2. Click the Move button 
3. Select the destination section 
4. Click Move 

To move entire sections: 

1. Check the box next to the section you want to move 
2. Click Move 
3. Select where you want to place it (inside another section 

or at the top level) 
4. Click Move 

To delete questions or sections: 

1. Check the boxes next to items you want to delete 
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2. Click Delete 
3. Confirm the deletion 

Important: Deleting questions from the Question Library does 
NOT remove them from quizzes where they’re already being 
used. 
Creating question variants for randomization 

Why create variants? Multiple versions of similar questions 
prevent students from sharing answers and reduce 
memorization of specific wording. 

Strategy: 

1. Create a question in your section 
2. Click on it to edit 
3. Click Copy 
4. Modify the copied question (change numbers, rearrange 

options, adjust wording) 
5. Save the variant 
6. Repeat to create 2-4 variants of each question 

When you import the section into a quiz, you can set 
Brightspace to randomly select one variant for each student. 
Adding titles and descriptions to questions 

Question titles: 

• Visible only to you in the Question Library (students never 
see them) 

• Help you identify and organize questions 
• Not required, but recommended for easy searching 
• Example: “Ch3_Photosynthesis_MC_Easy_v1” 

To add a title to question types without a title field: 

1. When creating/editing the question, click Options 
2. Click Add Short Description 
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3. Enter your title 

Question text: 

• This is what students see 
• Can include formatted text, images, videos, and links 
• Use the text editor to format and add media 

Further Resources 

• Creating Question Library questions (D2L documentation) 
• Question Types in Brightspace: Benefits and challenges 

(Memorial University) 
• Quiz Question Types (Langara EdTech) 

Using Question Library in Quizzes 

Now that you have a bank of questions organized in your 
Question Library, see the Creating a Quiz guide to learn how to 
quickly import questions from the Question Library into your 
quizzes. 

Contact edtech@langara.ca for more information. 
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If you are a Langara employee, self-register for Essentials 
to Excellence: A Brightspace Companion for Instructors. 
This Brightspace course compliments the technical 
instructions found here with use cases, examples, and 
advice. 
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Quizzes — Creating a Quiz 

Brightspace’s quiz tool allows you to create online 
quizzes, ranging from informal knowledge checks to 
high-stakes exams. This guide covers the essential 
steps for creating a basic quiz. For advanced 
features like randomization, question pools, and 
release conditions, see the Quizzes — Advanced 
Features Quick Start Guide. 

Quizzes — Creating a Quiz is Quizzes guide 2 of 3. 

Recommended Best Practices 

• Create quizzes directly in Content so they appear in your 
course modules 

• Use the Question Library to create and organize questions 
before building quizzes 

• Link quizzes to gradebook items before the term starts 
• Use Calculated Final Grade during the term for automatic 
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grade updates 
• Set due dates for lower-stakes quizzes; use availability 

dates for high-stakes exams 
• Choose asynchronous time limits for flexibility; use 

synchronous only when all students must start together 
• Use Treat ungraded items as 0 for accurate progress 

tracking 
• Balance exam integrity with exam anxiety when setting 

paging options 
• Only auto-publish results if all questions are reliably 

auto-gradable 

Before You Begin 

We highly recommend using the Question Library 
to create and organize questions before importing 
them into a quiz. See Using the Question Library 
Quick Start Guide. 

Consider preparing: 

• Questions in the Question Library: Organized in sections 
by topic or chapter 

• Gradebook structure: Set up your gradebook to link 
quizzes to existing grade items 

• Quiz instructions: Clear directions about time limits, 
allowed resources, and submission details 

Watch this overview of quiz creation: 
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One or more interactive elements has been 

excluded from this version of the text. You can 

view them online here: https://pressbooks.bccampus.ca/

langaraquickguides/?p=3278#oembed-1 

Creating a Quiz 

Our Recommendation 
Create quizzes directly in Content so they appear in 
your course modules. If you create quizzes via the 
Manage Quizzes page, students can only access 
them through the Tools menu unless you manually 
add them to your modules. 

Step-by-step instructions 

Step 1: Navigate to Quiz Location 

1. Go to Course Materials > Content 
2. Select the module where you want to add the quiz 
3. Click Upload/Create > New Quiz 

Step 2: Enter Quiz Details 

1. Title: Give the quiz a descriptive name (mandatory) 
2. Description: Add instructions students see before starting 
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the quiz 

◦ Include any special instructions, allowed resources, or 
expectations 

◦ Consider using larger font or color to make 
instructions stand out 

3. Save regularly as you build your quiz 

Step 3: Link to Gradebook (Grade Out Of) 

1. Set the point value in the Grade Out Of box 
2. Use the In Grades dropdown to: 

◦ Create a new gradebook item (default) 
◦ Link to an existing gradebook item (select Edit or Link 

to Existing) 
◦ Select a grade category if you’ve set them up 

Step 4: Add Questions from Question Library 

1. Click Add Existing dropdown 
2. Select Browse Question Library 
3. Check boxes next to sections or individual questions to 

import 
4. Click Import 

Step 5: Verify Total Points 

1. After adding questions, check that the Grade Out Of value 
matches your intended point total 

2. If the quiz is linked to the gradebook, manually adjust the 
point total to align with the sum of question points 

3. If the quiz is NOT linked to the gradebook, the points 
automatically match the question total and cannot be 
edited 
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Step 6: Set Dates 

Choose either Due Date OR Availability Dates (see detailed 
guidance below) 

Due Date: 

• Use for lower-stakes quizzes where late submissions are 
acceptable but marked as late 

• Students can submit after the deadline 
• Automatically appears in the course calendar 

Availability Dates (Start/End): 

• Use for high-stakes quizzes with strict time windows 
• Students can only begin the quiz during this window 
• Check the box to add availability dates to the calendar (not 

automatic) 

See also Dates, Deadlines, and Availability Quick Guide 

Step 7: Set Time Limit (Timing & Display) 

1. Expand the Timing & Display menu 
2. Check Set Time Limit to add a countdown clock to the 

quiz (by default, no time limit is set) 
3. Enter the time limit in minutes 
4. Click Timer Settings to control what happens when 

students exceed the time limit: 

◦ Automatically submit the quiz attempt (default) – 
quiz auto-submits when time expires 

◦ Flag as “exceeded time limit” and allow the learner 
to continue working – students can keep working but 
submission is flagged 

◦ Do nothing: the time limit is not enforced – 
countdown clock shows but no enforcement 

5. Within Timer Settings, choose between asynchronous 
(default) or synchronous timing (see detailed guidance 
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below) 

Important: Setting a time limit only displays a 
countdown clock to students unless you also 
configure Timer Settings to enforce the limit. The 
default setting automatically submits the quiz when 
time expires. 

Step 8: Configure Paging (Timing & Display) 

1. In Timing & Display, find the Paging dropdown 
2. Choose how many questions appear per page 
3. Decide whether to allow students to navigate backwards 

to previous pages 

Step 9: Set Category (Optional) 

Choose a category to organize quizzes by type, topic, or other 
grouping. 

Step 10: Configure Evaluation Settings (Evaluation & 
Feedback) 

1. Expand the Evaluation & Feedback menu 
2. Decide whether to auto-publish attempt results (only if all 

questions are auto-gradable – see guidance below) 
3. If linked to gradebook, check Synchronize to grade book 

on publish 
4. Configure feedback display options if desired (contact 

EdTech for help with this) 
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Step 11: Save and Preview 

1. Click Save 
2. Click Preview to test the exact student experience 
3. Check that all questions display correctly, time limits work, 

and navigation functions as expected 

Key Quiz Settings 

Due Dates vs Availability Dates 

Due Dates: Use for lower-stakes quizzes 

• Students can submit after the deadline but submissions 
are marked as late 

• More flexible for students with varying schedules 
• Automatically appear in the course calendar 

Availability Dates (Start/End): Use for higher-stakes quizzes 

• Students can only begin the quiz during the specified 
window 

• More control over when students take the assessment 
• Example: Quiz must be started between 3:00 PM and 3:20 

PM on October 21 
• Must manually check the box to add to calendar 

Our Recommendation 
Use one or the other to avoid confusing students. 
End dates override due dates. For most quizzes, use 
due dates for flexibility. Reserve availability dates 
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for high-stakes exams where you need strict timing 
control. 

Understanding the Difference 

Availability window (Start/End Dates): the time 
period during which a student can begin a quiz 
Time Limit: the amount of time the student has to 
complete a quiz once they’ve started it 

Time Limits: Synchronous vs Asynchronous 

Asynchronous (default): Students have the full time limit 
regardless of when they start 

• Best for: Asynchronous courses, lower-stakes quizzes, 
students with varying schedules 

• How it works: Timer starts when student clicks “Start 
Quiz” – each student gets full time even if starting near the 
end of availability window 

• Example: Quiz available Oct 1-3, 60-minute limit. Student 
starts Oct 3 at 11:59 PM, timer begins then and they get full 
60 minutes (until 12:59 AM Oct 4) 

Synchronous: Timer starts at the start time for all students 
simultaneously 

• Best for: In-class quizzes, high-stakes exams where you 
need all students to begin together 

• How it works: Timer begins at the Start Date for everyone. 
Students starting late forfeit time that has already passed 

• Example: Quiz starts Oct 21 at 3:00 PM, 60-minute limit. 
Student starting at 3:10 PM only has 50 minutes remaining 
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(quiz ends at 4:00 PM for everyone) 
• Important setup note: Use Start Date (required) and leave 

End Date empty – the quiz automatically ends when time 
limit expires 

• Student experience: “Start Quiz” button is disabled with 
countdown timer showing time until quiz becomes 
available 

To change from asynchronous to synchronous, click Timer 
Settings in the Timing & Display menu and select 
“Synchronous: Timer starts on the start date.” 

Our Recommendation 
Use asynchronous (default) for most quizzes to 
accommodate different schedules and reduce 
anxiety. Reserve synchronous timing for in-class 
quizzes or high-stakes exams where simultaneous 
start is essential for integrity. Important: Be very 
careful with synchronous quizzes – students must 
understand the importance of starting on time, as 
there’s no way to restore lost time except through 
individual accommodations that you must manually 
set and remove. 

Adding Time to a Quiz in Progress 

If you need to add time to a quiz while students are actively 
taking it, use the Special Access feature: 

1. Go to Course Admin > Manage Quizzes 
2. Click on the quiz name to edit 
3. Select Availability Dates & Conditions 
4. Click Manage Special Access 
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5. Ensure “Allow selected users special access to this quiz” is 
selected 

6. Click Add Users to Special Access 
7. In the Timing section, check Override time limit 
8. Enter the new time limit in minutes 
9. In the Users section, check the names of all students who 

need the extension 
10. Click Save, then Save and Close 
11. Important: Tell students to refresh their browsers for the 

new time setting to take effect 

Students must refresh their browsers for the 
updated time limit to take effect. Communicate this 
clearly when extending time during an active quiz. 

Paging: How Many Questions Per Page? 

The default shows all questions on one page. You can specify 
how many questions appear per page and whether students 
can navigate backwards. 

Considerations: 

• All questions on one page: Students see the full scope, 
can strategize, but increases opportunities for academic 
misconduct 

• One question per page with no going back: Reduces 
misconduct but significantly increases anxiety 

• Several questions per page with no going back: Balances 
integrity and anxiety 
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Our Recommendation 
Balance exam integrity with exam anxiety: Show 
several questions per page (giving students some 
choice about which to answer first) and check 
“Prevent going back to previous pages” to limit 
unlimited review of previous answers. This middle 
approach reduces both misconduct opportunities 
and student anxiety. 

Auto-Publishing Results 

When to auto-publish: Only if your quiz consists entirely of 
auto-gradable questions 

• Multiple choice 
• True/False 
• Multi-Select 
• Fill in the Blanks (with exact text matches) 
• Matching 
• Ordering 

When NOT to auto-publish: If any questions require review or 
manual grading 

• Fill in the Blanks with typed answers (need verification) 
• Short Answer 
• Written Response 

For quizzes requiring manual grading, uncheck “Auto-publish 
attempt results immediately upon completion” 

Don’t forget: If you linked the quiz to your gradebook, check 
“Synchronize to grade book on publish” or you’ll need to 
manually push scores. 
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Our Recommendation 
Auto-publish is fine for purely auto-gradable quizzes 
where students benefit from immediate feedback. 
For mixed question types or high-stakes 
assessments, save results as drafts so you can review 
before publishing to ensure accuracy and catch any 
issues with question wording or answer keys. 

Bonus Questions 

What are bonus questions? 
Bonus questions give students opportunities to earn extra 

points without penalty for skipping or answering incorrectly. 
Students are not penalized if they skip a bonus question or get 
it wrong. 

Setting up bonus questions: 

1. Add your questions to the quiz (from Question Library or 
create new) 

2. Check the box next to the question(s) you want to make 
bonus 

3. Click More Actions and select Toggle Bonus 
4. The question will show “BONUS” under its point value 
5. Click Save 

Gradebook settings for bonus questions: 
By default, bonus points replace missed points (maximum 

score remains 100%). If you want students to exceed 100%: 

1. Go to Grades in your course 
2. Click on the quiz grade item 
3. Check Can Exceed 
4. Click Save and Close 
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5. If your quiz is in a category, also check Can Exceed for that 
category 

Important: Questions randomly drawn from 
Question Pools cannot be designated as bonus 
questions. 

Allowing Students to Retake Only Incorrect Answers 

What is this feature? 
This setting allows students who attempt a quiz multiple 

times to retake only the questions they answered incorrectly 
on previous attempts. Questions they answered correctly are 
locked and automatically counted toward their new attempt. 

When to use this: 

• Practice quizzes where the goal is mastery of all concepts 
• Formative assessments focused on learning rather than 

evaluation 
• Self-assessment quizzes where students should focus on 

their gaps 

To enable this feature: 

1. Open your quiz for editing 
2. Go to Attempts & Completion 
3. Click Manage Attempts 
4. Set Attempts Allowed to 2 or more 
5. Check “On new attempts, only allow answers for 

previously incorrect questions” 
6. Under Overall Grade Calculation, select how attempts 

should be graded: 

◦ First Attempt: Only the first attempt counts (use this if 
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you want baseline performance) 
◦ Highest Attempt: System adds scores from all 

attempts together (can exceed 100%) 
◦ Average of All Attempts: Creates new average with 

each attempt 

7. Click OK, then Save and Close 

Important considerations: Written Response 
questions will show as 0 points until manually 
graded. If you use release conditions based on quiz 
grades, they will be based on the first attempt score 
if that’s what you’ve selected for grade calculation. 
While this seems useful for practice, sometimes it’s 
better to let students retry all questions, as they may 
have gotten an answer correct accidentally the first 
time. 

Controlling Student Feedback and 
Results Display 

Understanding what students can see: 
By default, students only see their overall score after you 

publish results. You can choose to show additional information: 

• Quiz score only: Students see their total points and 
percentage (default) 

• Question scores: Students see which questions they got 
right or wrong, but not what the correct answers are 

• Their responses: Students see what they selected or wrote 
• Correct answers: Students see what the correct answers 
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were 
• Question-level feedback: Students see any feedback you 

added to individual questions 

You can mix and match these options and control when 
students see them (immediately after submission, after the 
due date, after a specific date, etc.). 

Common approaches and considerations: 

• Practice quizzes or formative assessments: Show correct 
answers immediately so students can learn from mistakes. 
Since the goal is learning, integrity concerns are less 
significant. 

• Graded quizzes where you reuse questions: Show score 
and question scores immediately, but withhold correct 
answers. This allows students to know how they did 
without compromising your question pool for future 
terms. 

• Graded quizzes with in-class review: Show score only 
initially, then briefly show correct answers for a limited 
time during your in-class review session (1-2 days), then 
hide them again. This allows discussion without 
permanently compromising questions. 

• High-stakes exams: Show score only, never show 
questions or correct answers. This protects exam integrity 
if you plan to reuse questions. 

Important: Leaving questions and correct answers 
permanently visible compromises academic 
integrity if you plan to reuse questions. Students can 
(and do) share this information with future students. 
Consider whether the learning value of showing 
answers outweighs the integrity risk to your 
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question pool. 

Creating a custom feedback display (step-by-step) 

1. Open your quiz for editing 
2. Go to Evaluation & Feedback 
3. Click Customize Quiz Results Displays 
4. Click New to create a custom results view 
5. Give your results display a descriptive name (e.g., “Show 

Correct Answers After Due Date”) 
6. Under Quiz Summary, choose what students see: 

◦ Check Quiz Score to show the overall score 
◦ Check Questions to show the question text 
◦ Check User Responses to show what students 

selected 
◦ Check Correct Answers to show the correct responses 
◦ Check Question Scores to show points earned per 

question 
◦ Check Question Feedback to show any feedback you 

added to questions 

7. Under Availability, control when students can see this 
view: 

◦ Immediately: Students see it as soon as they submit 
◦ Automatically at a specified date: Set a specific date/

time when this view becomes available 
◦ After quiz availability end date: View appears after 

the quiz closes 

8. If you want to hide this view later (for the in-class review 
approach), set an End Date for when the view should no 
longer be available 

9. Click Save 
10. Back in the main quiz settings, click Save and Close 
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Example configuration for in-class review: 

• Create a view named “In-Class Review” 
• Check: Quiz Score, Questions, User Responses, Correct 

Answers 
• Set availability to start the day of your review session 
• Set end date for 2 days later 
• Students can see everything during your review window, 

then it disappears 

The feedback display options can be complex. 
Contact EdTech for assistance setting up custom 
result views that match your pedagogical goals and 
timeline. 

Final Steps 

1. Save your quiz regularly as you build it 
2. Preview your quiz before publishing – the preview 

replicates the exact student experience 
3. Test the time limit, navigation, and question display 
4. Verify that the point total is correct 

Further Resources 

• Using the Question Library Quick Start Guide 
• Quizzes — Advanced Features Quick Start Guide 
• Dates, Deadlines, and Availability Quick Start Guide 
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• Creating questions (D2L documentation) 
• Changes to the Brightspace Quiz Experience (video, 8:56) 

Now that you have a quiz set up, review advanced quiz 
features. 

Contact edtech@langara.ca for more information. 

If you are a Langara employee, self-register for Essentials to 
Excellence: A Brightspace Companion for Instructors 
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Quizzes — Advanced Features 

This guide covers advanced quiz features for 
enhancing academic integrity, providing 
accommodations, and creating sophisticated 
assessments. Before using these features, make 
sure you’re comfortable with basic quiz creation (see 
Creating a Quiz Quick Start Guide). 

Quizzes — Advanced Features is Quizzes guide 3 
of 3. 

Overview 

Advanced quiz features allow you to: 

• Support academic integrity through randomization 
• Provide individualized accommodations and extensions 
• Control when and how students access quizzes 
• Customize the feedback students receive 
• Organize complex assessments with multiple sections 
• Accept multiple answer formats using regular expressions 
• Analyze quiz performance through reports and statistics 

Quizzes - Advanced Features  |  139



Need help implementing these features? Contact 
EdTech at [email protected] for one-on-one support. 

Question Pools and 
Randomization 

What are Question Pools? 

A question pool is a collection of questions stored in the 
Question Library from which Brightspace randomly selects a 
specified number for each student’s quiz. 

Benefits: 

• Each student sees a different subset of questions 
• Reduces opportunities for sharing answers 
• Allows you to reuse questions across terms without 

students seeing identical quizzes 

Example: You create a pool of 20 questions about Chapter 3. 
The quiz pulls 10 random questions from this pool. Student A 
gets questions 2, 5, 7, 9… while Student B gets questions 1, 4, 8, 
11… 

Important: Questions in the same pool should be of 
similar difficulty to ensure fairness. Don’t mix easy 
and hard questions in one pool. 

Creating a Question Pool 
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Step 1: Organize Questions in the Question Library 
Before creating a pool, you need questions organized in 

sections: 

1. Go to Course Admin > Quizzes > Question Library 
2. Click New > Section 
3. Name the section (e.g., “Chapter 3 – Intermediate 

Difficulty”) 
4. Add questions to this section 
5. Create more questions than you’ll use in the quiz (e.g., 20 

questions if you want students to answer 10) 

Step 2: Add the Pool to Your Quiz 

1. Open your quiz for editing 
2. In the Questions section, click Create New > Question 

Pool 
3. Give the pool a descriptive name (students don’t see this) 
4. Click Browse Question Library 
5. Check the box next to the section you created 
6. Click Import 
7. Enter the Number of Questions to Select (how many 

questions each student will see from this pool) 
8. Enter Points per Question 
9. Click Save 

Our Recommendation 

Create pools with 1.5-2 times as many questions as you want 
students to answer. For example, if you want students to 
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answer 10 questions, create a pool of 15-20. This ensures variety 
while keeping your workload manageable. 
Using Multiple Pools for Different Difficulty Levels 

You can create several pools in one quiz to control the 
distribution of question difficulty: 

Example scenario: A quiz with easy, medium, and hard 
questions 

1. Create three sections in your Question Library: 

◦ “Chapter 3 – Easy” (10 questions) 
◦ “Chapter 3 – Medium” (10 questions) 
◦ “Chapter 3 – Hard” (8 questions) 

2. In your quiz, create three separate pools: 

◦ Pool 1: Pull 5 questions from “Easy” section, 2 points 
each 

◦ Pool 2: Pull 3 questions from “Medium” section, 3 
points each 

◦ Pool 3: Pull 2 questions from “Hard” section, 5 points 
each 

3. Total quiz: 10 questions, 29 points possible 

Each student gets a different combination of questions, but 
everyone has the same difficulty distribution. 
Additional Randomization Options 

Beyond question pools, you can randomize in other ways: 
Shuffle Question Order: 

• Go to Timing & Display in your quiz settings 
• Check Shuffle questions and sections within the quiz 
• Students see questions in random order (useful even 

without pools) 

Randomize Answer Choices: 
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• When creating or editing a multiple choice or multi-select 
question 

• Check Randomize answer order below the answer 
options 

• Each student sees answer choices in a different order 
• Caution: Don’t use this if you have “All of the above” or 

“None of the above” options 

Special Access: Accommodations 
and Extensions 

What is Special Access? 

Special Access allows you to provide individual students or 
groups with different quiz settings than the rest of the class. 

Common uses: 

• Extended time for students with accommodations 
• Different due dates for students with extenuating 

circumstances 
• Additional quiz attempts after technical difficulties 
• Earlier or later access windows 

Providing Extended Time 

1. Go to Course Admin > Manage Quizzes 
2. Click the quiz name to edit it 
3. Select Availability Dates & Conditions 
4. Click Manage Special Access 
5. Select Allow selected users special access to this quiz 
6. Click Add Users to Special Access 
7. Under Timing, check Override time limit 
8. Choose one option: 

◦ Multiplier of original quiz time: Enter 1.5 for 
time-and-a-half, 2.0 for double time 
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◦ Extra time: Enter additional minutes to add to the 
original time limit 

◦ No time limit: Remove the time limit entirely 

9. Under Users, check the box next to each student who 
needs this accommodation 

10. Click Save, then Save and Close 

Special Access settings override the default quiz 
settings. Make sure to double-check that you’ve 
selected the correct students before saving. 

Providing Additional Attempts 

1. Follow steps 1-6 from “Providing Extended Time” above 
2. Under Attempts, check Override attempts allowed 
3. Select the number of attempts from the dropdown 
4. (Optional) Set Advanced Attempt Conditions if you want 

to require students to achieve a minimum score before 
getting another attempt 

5. Under Users, check the box next to each student who 
needs additional attempts 

6. Click Save, then Save and Close 

Changing Availability Dates for Individual Students 

1. Follow steps 1-6 from “Providing Extended Time” above 
2. Under Availability, check Has Start Date and/or Has End 

Date 
3. Set the custom dates and times for the selected students 
4. Under Users, check the box next to each student who 

needs different dates 
5. Click Save, then Save and Close 
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Example use case: Most students take the quiz Oct 15-17, but 
one student has a conflict and needs to take it Oct 18-19 
instead. 
Managing Special Access 

To view which students have Special Access: 

• Quizzes with Special Access show a key icon on the 
Manage Quizzes page 

• Open the quiz and go to Availability Dates & Conditions > 
Manage Special Access to see the full list 

To edit Special Access: 

• Click the pencil icon next to the student’s name 
• Make your changes 
• Click Save 

To remove Special Access: 

• Click the X next to the student’s name 
• Click Save and Close 

Release Conditions 

What are Release Conditions? 

Release Conditions control when a quiz becomes available 
based on whether students have completed other course 
activities. 

Common uses: 

• Require students to complete a practice quiz before 
accessing the graded quiz 

• Make Quiz 2 available only after Quiz 1 is submitted 
• Ensure students have viewed required content before 

attempting an assessment 
• Restrict quizzes to specific groups or sections 
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Setting a Release Condition 

1. Open your quiz for editing 
2. Go to Availability Dates & Conditions 
3. Click Create Release Condition 
4. Choose the type of condition: 

◦ Content Viewed: Student must view specific content 
◦ Activity Completed: Student must complete an 

assignment, discussion, or quiz 
◦ Grade Value: Student must achieve a certain grade on 

another activity 
◦ Group Membership: Student must be in a specific 

group 

5. Select the specific item or group 
6. Click Create 
7. Click Save and Close 

Our Recommendation 

Use release conditions for sequential assessments where later 
quizzes build on earlier ones, or to ensure students engage 
with preparatory materials before attempting high-stakes 
assessments. 

Custom Result Views: Controlling 
Feedback 

Understanding Quiz Feedback Options 
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By default, students only see their overall score after 
completing a quiz. You can customize what they see, including: 

• Individual question scores 
• Correct answers 
• Question-level feedback 
• Which answers they selected 

You can also control when students see different types of 
feedback (immediately after submission, after the due date, 
after all attempts, etc.). 
Creating a Custom Result View 

This feature is complex and has many options. 
Contact EdTech for help configuring custom 
feedback displays that match your pedagogical 
goals. 

Basic steps: 

1. Open your quiz for editing 
2. Go to Evaluation & Feedback 
3. Click Customize Quiz Results Displays 
4. Click New to create a custom view 
5. Choose what students can see (questions, answers, 

feedback, correct answers, etc.) 
6. Set when this view is available (immediately, after due 

date, after specific date, etc.) 
7. Click Save 

Common configurations: 

• Practice quizzes: Show everything immediately so 
students can learn from mistakes 
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• Graded quizzes: Show score immediately, withhold 
correct answers until after due date 

• High-stakes exams: Show score only, never show 
questions or answers 

Anonymous Grading 

What is Anonymous Grading? 

Anonymous grading hides student names when you’re 
reviewing and grading written response or short answer 
questions, helping reduce unconscious bias. 

How it works: 

• Student names are hidden during grading 
• Students appear as “Anonymous User 1,” “Anonymous User 

2,” etc. 
• You can still provide feedback, which is saved as drafts 
• Once you publish all feedback, names are revealed 

Enabling Anonymous Grading 

1. Open your quiz for editing 
2. Go to Evaluation & Feedback 
3. Check Enable anonymous marking 
4. Click Save 

Important limitations: You cannot disable 
anonymous marking after students have submitted. 
You must publish ALL feedback at once using 
“Publish All Feedback” – you cannot publish grades 
individually. 
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Quiz Sections 

What are Quiz Sections? 

Quiz sections allow you to organize questions into groups 
within a single quiz. 

Benefits: 

• Organize questions by topic, difficulty, or question type 
• Apply different randomization settings to different 

sections 
• Give sections different point values 
• Create more complex quiz structures 

Example: A quiz with three sections: 

• Section 1: Multiple choice questions (20 points) 
• Section 2: Short answer questions (30 points) 
• Section 3: Essay question (50 points) 

Creating Quiz Sections 

1. Open your quiz for editing 
2. In the Questions area, click Create New > Section 
3. Give the section a name 
4. Click Save 
5. Add questions to this section by clicking Create New > 

New Question or Add Existing > Browse Question Library 
6. Repeat to create additional sections 

Using sections with question pools: 

• You can create a question pool within a section 
• Each section can have its own pool with different 

randomization settings 
• This allows sophisticated quiz structures (e.g., 5 random 

multiple choice from Section 1, 3 random short answer 
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from Section 2) 

Regular Expressions for 
Fill-in-the-Blank Questions 

What are Regular Expressions? 

Regular expressions (regex) allow you to accept a wider range 
of student responses as correct in auto-graded quiz questions. 
This is especially useful for questions where multiple formats of 
the same answer are acceptable. 

Common uses: 

• Accepting both Canadian and American spellings (e.g., 
“colour” or “color”) 

• Accepting answers with or without decimal places (e.g., 
“250” or “250.0”) 

• Accepting dates in multiple formats (e.g., “Sept. 5” or 
“September 5th”) 

• Accepting scientific notation and measurement variations 

Supported question types: 

• Short Answer 
• Multi-Short Answer 
• Fill in the Blanks 
• Arithmetic 
• Significant Figures 

Common Regular Expression Patterns 

Here are some frequently used regex patterns: 
colou?r – Matches “colour” or “color” (the ? makes the 

preceding character optional) 
250(\.0+)? – Matches “250” or “250.0” or “250.000000” 
July (first|1st|1) – Matches “July first”, “July 1st”, or “July 1” 
gr[ae]y – Matches “gray” or “grey” 
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250\s*mL – Matches “250mL” or “250 mL” or “250 mL” (allows 
zero or more spaces) 

Important: Regular expressions are case-sensitive 
by default. Test your regex thoroughly before using 
it in a live quiz. 

Setting Up a Regex Question 

1. Go to Course Admin > Quizzes > Question Library 
2. Select New and choose your question type (Short Answer, 

Fill in the Blanks, etc.) 
3. Enter your question text 
4. Critical step: In the answer field dropdown, change from 

Text to Regular Expression 
5. Enter your regex pattern in the answer field 
6. Click Save 

Testing your regex: 

1. Before using in Brightspace, test at regexr.com 
2. Enter your regex in the Expression field 
3. Enter test answers in the Text field 
4. If your regex works, the text will highlight in blue 
5. After adding to a quiz, preview the quiz and grade preview 

attempts to verify auto-grading works correctly 

Our Recommendation 
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Regex is powerful but complex. Start with simple patterns for 
common variations (like Canadian/American spelling) before 
attempting complex expressions. Contact EdTech for help 
with discipline-specific regex patterns. 

Quiz Reports and Statistics 

Understanding Quiz Statistics 

Brightspace provides detailed analytics about quiz 
performance at both the individual and class level. 

Three types of statistics available: 

• User Stats: Score distribution, class average, individual 
student grades 

• Question Stats: Average score, standard deviation, 
discrimination index, and point biserial for each question 

• Question Details: Detailed analysis showing which 
answers students selected and how many times 

To access statistics: 

1. Go to Manage Quizzes 
2. From the quiz dropdown menu, select Statistics 
3. Click through the tabs: User Stats, Question Stats, 

Question Details 
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Statistics help you identify problematic questions, 
understand student performance patterns, and 
make data-informed decisions about your 
assessments. 

Creating Custom Quiz Reports 

Quiz reports allow you to generate and share anonymous quiz 
data with specific audiences. 

When to create a report: 

• You want to analyze quiz data offline (export to Excel or 
CSV) 

• You need to share anonymous quiz statistics with 
colleagues 

• You want to release specific data to students at specific 
times 

Five report types available: 

• Question Statistics: Average scores and statistical 
measures for each question 

• Question Details: Shows which answers students chose 
and how frequently 

• User Statistics: Class average, score distribution, and 
individual grades 

• Attempt Details: Detailed information about each 
attempt including completion time 

• User Attempts: Shows scores and attempts for each 
student 

To create a report: 

1. From the quiz dropdown menu, select Setup Reports 
2. Click Add Report 
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3. Enter a report name 
4. Select a Report Type 
5. Choose which data to include using the checkboxes 
6. Set a release date (optional) 
7. Select which roles can access the report 
8. Click Save 

To view a report: 

1. From the quiz dropdown menu, select View Reports 
2. Click on the report name 
3. Choose your format: CSV, Excel, or HTML 

Best Practices for Advanced 
Features 

Test thoroughly: Preview quizzes after setting up advanced 
features to ensure they work as intended. If using question 
pools or randomization, preview multiple times to see different 
question combinations. 

Communicate with students: If you’re using randomization, 
let students know they may see different questions than their 
peers. If using release conditions, explain what they need to 
complete first. 

Document your Special Access: Keep a record of which 
students have accommodations or extensions, especially if 
you’re managing multiple special access scenarios. 

Start simple: Don’t try to use all advanced features at once. 
Start with one (like question pools) and add others as you 
become comfortable. 

Balance security and anxiety: More randomization and 
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restrictions increase academic integrity but can also increase 
student anxiety. Find the right balance for your context. 

Further Resources 

• Creating a Quiz Quick Start Guide 
• Using the Question Library Quick Start Guide 
• D2L: Manage quiz questions 
• D2L: About Special Access 
• D2L: Set up release conditions 

Contact edtech@langara.ca for more information. 

If you are a Langara employee, self-register for Essentials to 
Excellence: A Brightspace Companion for Instructors 
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Discussions 

Discussions are an effective way to stimulate 
student engagement and collaboration, foster a 
sense of community, offer feedback, and help 
students explore the course content. Asynchronous 
discussions encourage deeper reflection and critical 
thinking, enhance student exposure to various 
course materials, present students with diverse 
perspectives, and enable instructors to assess 
student learning. 

Discussions is Discussions guide 1 of 2. 

Setting up a discussion forum, 
topic, and thread 

D2L discussions are organized into the following: 

• Forum: broad categories for discussion 
• Topic: specific discussions within the forum 
• Thread: student response within the topic 

Adding a Topic and Forum 
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1. Navigate to Course 
Materials > Content. 

2. From the Table of 
Contents, select the 
module where you’d like 
to add the Discussion. 

3. Click Upload/Create 
> New Discussion if you 
are creating a new 
discussion. If your 
Discussion already exists, 
you can click Existing 
Activities > Discussion 
and select the Forum/
Topic you wish to add. 

4. Give your new topic a 
Topic Title and add 
instructions for your 
students in the 
Description textbox. You 
can set availability dates, 
release conditions, and 
group restrictions to 
your topic. You can also 
add rubrics and evaluate 
topics, if you provide a Grade Out Of score. 
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5. Click Change Forum to add a new Forum or link to an 
existing Forum. 

6. If you are creating a new forum, provide a Forum Title or if 
a forum exists, choose it from the dropdown. Click Apply 
Changes. 
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Note: Forums are used to group discussion topics. Users 
cannot post to Forums directly; posting requires a topic to 
be created first. 

7. At the bottom of the screen, toggle the topic from Hidden 
to Visible. 

8. Click Save and Close when done. 

Group Discussions 

As part of the Groups creation process, you have the option to 
create associated Discussions at the same time. However, it’s 
also possible to create Discussions and Groups separately and 
then connect them later. 

If you want to link a Discussion with Groups, you can link 
them in the Topic settings. 

• Go to Communication > Discussions 
• Find the name of the Discussion topic, click the arrow to 

show the drop-down, and select Edit Topic from the 
options 
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• Expand the Availability Date & Conditions settings on the 
right 

• Click on Manage Restrictions 

To manage restrictions, take the following steps: 
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1. Group and Section Restrictions: Select Restrict topic and 
separate threads 

2. Select who will see this topic: Select the Group you want 
to link to in the drop-down options 

3. Click Add 

Editing Topics 

If you need to make any updates or changes to a topic, 
navigate to Communication > Discussions. Expand the 
dropdown menu beside the topic and select Edit Topic. 

Adding Additional Topics 

Additional topics can be added to already created forums. 
To do this, expand the dropdown menu in the discussion 
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forum you wish to add another topic and click Add Topic. 

Adding a Thread/Post 

1. In the topic where you want to add a thread, click Start 
a New Thread. 
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2. Add a title to the thread and discussion into the 
textbox. In Brightspace Discussions, you are not limited 
to posting text. You can post video, audio, images, etc. 
Consider giving students options in their modes of 
expression.

3. Click Post. 

Further Resources 

• Asynchronous discussions – how and why 
• Effective Practices for Teaching with Online Discussions 
• Facilitating Discussions in D2L 
• Online Discussions: Tips for Instructors 
• Online Discussions: Tips for Students 
• Online Discussion Questions That Work 
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Discussions can also be used as an assessment. Move to the 
next quick guide on assessing topics to learn about easy 
grading of discussions. 

Contact edtech@langara.ca for more information. 

If you are a Langara employee, self-register for Essentials 
to Excellence: A Brightspace Companion for Instructors. 
This Brightspace course compliments the technical 
instructions found here with use cases, examples, and 
advice. 
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Rubrics 

Rubrics in Brightspace are powerful tools for 
evaluating student work consistently and 
transparently. They provide clear grading criteria, 
making assessments more objective and consistent 
while offering students valuable feedback on their 
performance. Rubrics help students better 
understand expectations and how their work will be 
evaluated. Rubrics also aid instructors by creating an 
efficient, repeatable marking system. This guide will 
help you create, attach, and use Brightspace rubrics 
effectively. 

Before you begin creating rubrics, it’s important to understand 
the two main types of rubrics available and how they can be 
used to align with your teaching goals. 

Types of Rubrics 

Analytic Rubrics 

• Description: Analytic rubrics evaluate student work based 
on multiple criteria, with each criterion assessed across 
defined levels of achievement. This type provides detailed 
feedback on specific aspects of a student’s work. 

• Structure: Each row represents a criterion (e.g., clarity, 
organization, depth of analysis), and each column 
represents a level of achievement (e.g., Exemplary, 
Proficient, Developing, Beginning). 

• Use Case: Ideal for assignments where multiple 
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components are being assessed, such as essays, projects, 
or presentations. 

Holistic Rubrics 

• Description: Holistic rubrics provide a single overall score 
for student work, based on an overall impression of 
performance. Feedback is less detailed but faster to apply. 

• Structure: The rubric consists of descriptive levels of 
performance, each with a point value. 

• Use Case: Best suited for quick assessments or tasks 
where a single criterion captures overall performance, 
such as participation or creative expression. 
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Choosing the Right Rubric Type 
• Use analytic rubrics for detailed, criterion-based feedback 

that guides students in improving specific aspects of their 
work. 

• Use holistic rubrics for quick assessments or when you 
want to emphasize an overall impression rather than 
dissecting individual components. 

Getting Started with Rubrics in 
Brightspace 

Step 1: Create a New Rubric 

1. Access the Rubrics Tool: 

◦ From your course navigation bar, go to Course Admin 
> Rubrics. 

2. Create a New Rubric: 

◦ Click New Rubric. 

3. Enter Rubric Details: 
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◦ Provide a Name for your rubric. 
◦ Choose the appropriate Status (e.g., Published or 

Draft). 
◦ Set the Rubric Type: 

▪ Analytic: Multiple criteria with different levels of 
achievement. 

▪ Holistic: A single, overall criterion for evaluation. 

4. Add Criteria and Levels: 

◦ Use the default criteria or click Add Criterion to create 
new ones. 

◦ Define levels (e.g., Exemplary, Proficient, Developing, 
Beginning) and their associated point values. 

Watch the following video to see how to create a new rubric 
and learn some quick tips. 

One or more interactive elements has been 

excluded from this version of the text. You can 

view them online here: https://pressbooks.bccampus.ca/

langaraquickguides/?p=2072#oembed-1 

Step 2: Attach a Rubric to an Activity 

1. Navigate to the Activity: 

◦ Open the assignment, discussion, or quiz where you 
want to attach the rubric. 

2. Add the Rubric: 

◦ In the activity settings, locate the Evaluation & 
Feedback section. 

◦ Click Add Rubric and select the rubric. 
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3. Save Changes: 

◦ Click Save and Close to attach the rubric to the 
activity. 

Step 3: Assess an Activity with a Rubric 

Watch the following video to learn how to how to grade using 
rubrics. 

One or more interactive elements has been 

excluded from this version of the text. You can 

view them online here: https://pressbooks.bccampus.ca/

langaraquickguides/?p=2072#oembed-2 

Additional Information 

Rubric Settings: Brightspace rubrics can be used for scoring 
(with points) or feedback-only purposes. Choose the option 
that aligns with your grading approach. 
Visibility to Students: You can decide whether to make rubrics 
visible to students before or after grading. Sharing rubrics in 
advance helps clarify expectations and supports 
self-assessment. 
Reusability: Rubrics can be copied and adapted for multiple 
assignments or courses, saving time and ensuring consistency. 

Contact edtech@langara.ca for more information. 
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If you are a Langara employee, self-register for Essentials 
to Excellence: A Brightspace Companion for Instructors. 
This Brightspace course compliments the technical 
instructions found here with use cases, examples, and 
advice. 
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Checklists 

The Brightspace Checklists tool helps students 
track their progress by providing interactive to-do 
lists. Students check off items as they complete 
them, giving them a clear view of what’s done and 
what still needs attention. Checklists are particularly 
useful for helping students stay organized and 
manage their workload across modules or weeks. 

Recommended Best Practices 

• Use checklists to break down complex tasks or multi-step 
processes into manageable pieces 

• Create weekly or module-based checklists to help 
students track required activities 

• Add descriptions and use quicklinks to connect checklist 
items directly to relevant course materials 

• Be thoughtful about adding due dates to checklist items, 
since these appear in the course calendar and the Work to 
Do widget alongside assignment deadlines 

• Keep checklist items clear and action-oriented (for 
example, “Complete Module 2 Quiz” rather than “Module 2 
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Quiz”) 

When to Use Checklists 

Checklists work well when you want to: 

• Guide students through multi-step processes: Break 
down complex assignments, research projects, or lab 
procedures into sequential tasks 

• Organize weekly or modular activities: Help students 
track readings, activities, and assessments within a 
specific timeframe 

• Support assignment preparation: Provide a checklist of 
steps students should complete before submitting major 
work 

• Encourage self-assessment: Create reflection prompts or 
skill-building tasks that students can work through at 
their own pace 

Creating a Checklist 

Step-by-step instructions 

Step 1: Access the Checklists Tool 

1. Go to Course Admin 
2. Under the Assessment section, select Checklists 
3. Click New Checklist 

Step 2: Set Up Your Checklist 

1. Name: Give your checklist a descriptive title (for example, 
“Week 3 Tasks” or “Research Essay Preparation”) 
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2. Description: (Optional) Add instructions or context for 
students about how to use this checklist 

3. New window option: You can check “Open this checklist 
in a new window when viewed” if you want the checklist 
to always open separately, though most instructors leave 
this unchecked 

4. Click Save 

Step 3: Create Categories 

Categories help organize your checklist items into logical 
groups. For example, a weekly checklist might have categories 
for “Readings,” “Activities,” and “Assessments.” 

1. Click New Category 
2. Give your category a name 
3. Add a description if needed 
4. Click Save 
5. Repeat to add more categories if your checklist needs 

them 

Step 4: Add Items to Your Categories 

1. Click New Item 
2. Choose which Category this item belongs to from the 

dropdown menu 
3. Name: Write a clear, action-oriented task (for example, 

“Read Chapter 4” or “Complete discussion post”) 
4. Description: (Optional) Add details or instructions 

◦ You can use the Insert Quicklink button to link directly 
to course materials, assignments, discussions, or 
quizzes 

5. Due Date: (Optional) Consider whether adding a due date 
is helpful 
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◦ If checked, set the date and time 
◦ You can also check “Display in Calendar” to show this 

due date in students’ calendars 
◦ Keep in mind that checklist due dates appear 

alongside assignment deadlines in the Work to Do 
widget, so use them thoughtfully to avoid 
overwhelming students 

6. Click Save or Save and New to add another item 

Step 5: Add Checklist to Course Content 

After creating your checklist, you need to make it visible to 
students by adding it to a module. 

1. Go to Course Materials > Content 
2. Navigate to the module where you want the checklist to 

appear 
3. Click Existing Activities dropdown 
4. Select Checklist 
5. Choose the checklist you created 
6. Click Insert 

Watch this video to see the process for creating an itemized 
checklist 

One or more interactive elements has been 

excluded from this version of the text. You can 

view them online here: https://pressbooks.bccampus.ca/

langaraquickguides/?p=3301#oembed-1 
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Managing Your Checklists 

Editing Checklists, Categories, and Items 

To make changes to an existing checklist: 

1. Go to Course Admin > Checklists 
2. Click on the checklist name you want to edit 
3. Make your changes to the checklist name, description, 

categories, or items 
4. Click Save and Close 

You can also edit individual categories or items directly from 
the Edit Checklist page by selecting the checkbox next to the 
item and clicking Edit. 
Reordering Items 

To change the order of categories or items: 

1. On the Edit Checklist page, click Reorder 
2. Use the dropdown menus to select new order numbers 
3. Click Save 

Previewing as a Student 

Before making your checklist live, preview it to see what 
students will experience: 

1. Go to Course Admin > Checklists 
2. Expand the dropdown menu next to your checklist name 
3. Click Preview in a new window 
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Tips for Effective Checklists 

Keep items actionable: Write each item as something 
students can complete and check off. Use verbs like “read,” 
“complete,” “review,” “submit,” or “participate.” 

Use quicklinks strategically: When adding descriptions to 
checklist items, use the Insert Quicklink feature to link directly 
to the relevant assignment, discussion, reading, or quiz. This 
saves students time and reduces confusion about where to 
find materials. 

Consider calendar integration carefully: While you can add 
due dates to checklist items, remember that these appear in 
students’ calendars alongside assignment, quiz, and discussion 
deadlines. Too many calendar items can overwhelm students, 
especially when they’re enrolled in multiple courses. Use 
checklist due dates when they add value beyond what’s 
already in your gradebook. 

Group logically: Use categories to organize items in a way 
that makes sense for your course structure. Weekly categories 
work well for some courses, while topic-based or activity-type 
categories might be better for others. 

Further Resources 

• D2L: Create a checklist 
• Dates, Deadlines, and Availability Quick Guide 
• Set up release conditions (for advanced checklist options) 

Contact edtech@langara.ca for more information. 
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If you are a Langara employee, self-register for Essentials 
to Excellence: A Brightspace Companion for Instructors. 
This Brightspace course compliments the technical 
instructions found here with use cases, examples, and 
advice. 
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Dates, Deadlines, and Availability 

Adding dates to items in Brightspace helps both 
you and your students stay organized. Dates create 
a clear timeline of course activities, support effective 
time management, and provide students with a 
roadmap for completing their work. This guide 
explains how to use due dates, start dates, end 
dates, and visibility settings effectively. 

Important: If your content, activity, or assessment is 
Hidden to students (indicated by an eye with a line 

through it ), nothing will be visible to students 
regardless of date, deadline, or availability settings. 

Understanding Brightspace Date 
Terminology 

Due Date 

A due date indicates when an activity or assignment should be 
submitted or completed. 

Key characteristics: 

• Due dates do not prevent access or submission 
• Students can submit after the due date, but Brightspace 

marks the submission as late 
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• Due dates automatically appear in the course calendar 
• Students receive notifications about approaching due 

dates (unless they’ve turned off notifications) 

Start Date (Availability) 

A start date controls when content or activities become 
accessible to students. 

Key characteristics: 

• Students cannot access the item before the start date 
• Start dates can be combined with visibility settings to 

control what students see before access opens 
• Useful for sequencing content or preventing students 

from working ahead 

End Date (Availability) 

An end date acts as a firm deadline that prevents further 
access. 

Key characteristics: 

• End dates completely close access – students cannot 
view or submit after this time 

• There is no option for late submissions after an end date 
passes 

• End dates override due dates when both are set 
• Use Special Access to provide extensions for individual 

students 

Special Access 

Special Access allows you to create exceptions for specific 
students, providing different due dates or availability windows. 

Common uses include accommodations, extended 
deadlines for individual circumstances, or different timing for 
different sections. 

Learn more about Special Access 
Display to Calendar 
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The Display to Calendar checkbox controls whether dates 
appear in students’ course calendars. Most due dates 
automatically appear in the calendar, but some availability 
dates (like discussion start/end dates) require you to check this 
box. 

Due dates, start dates, and end dates can be 
added to Content topics, Content modules, 
Discussions, Quizzes, Assignments, and Surveys. 

Setting Dates for Assignments 

Assignment folders allow you to set both due dates and 
availability windows (start and end dates). 

Recommended Approach: Due Dates with 
Optional End Dates 

• For most assignments: Set a due date to track on-time vs. 
late submissions. This allows students to submit late while 
Brightspace marks the submission accordingly. 

• To completely close submissions: Add an end date after 
the due date. This creates a window for late submissions 
before the assignment folder closes entirely. 

• Avoid confusion: Using both due dates and end dates can 
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confuse students. If you set both, make sure the purpose 
of each date is clear in your assignment instructions. 

Example scenario: 

• Due date: Friday, March 28 at 11:59 PM (on-time deadline) 
• End date: Sunday, March 29 at 11:59 PM (late submissions 

accepted until this time, then folder closes) 

Visibility Settings for Assignment Folders 

When you set start or end dates for assignments, you can 
control what students see before or after those dates: 
Visibility Options 

Visible with access restricted (before start / after end): 

• Students can see the assignment name and dates 
• They cannot click to open it or view details 
• They cannot see the description, attachments, or rubrics 

Visible with submission restricted (before start / after end): 

• Students can see and open the assignment 
• They can view the description, attachments, and rubrics 
• They cannot submit files or mark as complete 
• Useful for letting students prepare before the submission 

window opens 

Hidden (before start / after end): 

• The assignment is completely hidden from students 
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• Calendar events and notifications are also hidden 

Add availability dates to Calendar: Check this box to add the 
start and end dates to the course calendar. 

Setting Dates for Quizzes 

Quiz settings allow you to set due dates, start dates, and end 
dates. However, you should typically use either due dates OR 
availability dates, not both, as this can confuse students. 

When to Use Due Dates 

Use due dates when: 

• The quiz is low-stakes or formative 
• The quiz is available throughout the semester 
• You want to allow late attempts 

How due dates work: 

• Students can attempt the quiz after the due date, but it’s 
marked as late 

• Due dates automatically appear in the calendar 

When to Use Start/End Dates (Availability 
Windows) 

Use start and end dates for controlled access, especially for: 

• Higher-stakes assessments or exams 
• Timed quizzes that must be completed within a specific 

window 
• Ensuring academic integrity by limiting access 

How availability dates work: 

• Start and end dates control when students can begin the 
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quiz, not how long they have to complete it 
• Example: A 90-minute exam with a start date of April 6 at 

10:00 AM and an end date of April 6 at 10:30 AM means 
students can begin anytime between 10:00 and 10:29, then 
get the full 90 minutes to complete it 

• Start and end dates do NOT automatically appear in the 
calendar – check “Add availability dates to Calendar” to 
include them 

Our Recommendation 
Choose one approach or the other, not both. End 
dates override due dates, so using both creates 
unnecessary complexity. Use due dates for 
low-stakes quizzes where late attempts are 
acceptable. Use availability dates (start/end) for 
high-stakes assessments where you need controlled 
access. 

Setting Dates for Discussions 

Discussions work differently than assignments and quizzes 
when it comes to dates. 
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Due Dates for Discussions 

To set a due date for a discussion: 

1. Add the discussion to a Content module as a link (go to 
Content > Existing Activities > Discussions) 

2. Click the dropdown arrow next to the discussion link 
3. Select Edit Properties in Place 
4. Set the due date 

This due date will appear in the course calendar and remind 
students to complete the discussion. 

Availability Dates for Discussions 

You can also set start and end dates to control when students 
can post: 

1. Go to Discussions from the course navbar 
2. Click the dropdown menu next to the discussion topic and 

select Edit Topic 
3. Go to the Availability Dates and Conditions section 
4. Set start and/or end dates 

Visibility Settings for Discussions 

When setting availability dates for discussions, you can control 
what students see and do outside those dates: 
Visibility Options 

Visible with access restricted: 

• Students can see the discussion title but cannot access it 

Visible with submission restricted: 

• Students can view the topic and read posts 
• They cannot post new threads or replies (makes the 
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discussion read-only) 
• Useful for keeping discussions open for review after the 

posting deadline 

Hidden: 

• The discussion is completely hidden from students 
• Calendar events and notifications are also hidden 

Add availability dates to Calendar: Check this box to add the 
start and end dates to the course calendar. 

Our Recommendation 
After a discussion ends, consider setting it to “Visible 
with submission restricted” so students can review 
the conversation without adding new posts. You can 
also pin a summary thread at the top to highlight 
key takeaways. 

Managing Dates Efficiently 

Using the Manage Dates Tool 

The Manage Dates tool provides a central location to view and 
edit dates across your entire course. This is particularly useful 
when: 

• You need to review all dates at once 
• You’re copying a course from a previous term and need to 

update dates 
• You want to bulk edit or offset dates 
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To access Manage Dates: 

1. Go to Course Admin 
2. Under the Site Resources section, select Manage Dates 
3. Use filters to view specific tool types (Assignments, 

Quizzes, Discussions, etc.) 
4. Click on individual dates to edit them or use bulk editing 

tools 

The Manage Dates tool shows: 

• All content topics, modules, discussions, assignments, 
quizzes, and surveys with dates 

• Start dates, end dates, and due dates 
• Whether items are visible to students 
• Whether dates display in the calendar 

Learn more about the Manage Dates tool 

Common Questions 

What happens if I set both a due date and an end date? 

End dates override due dates. If both are set, students can 
submit after the due date (marked as late) until the end date, 
when access closes completely. However, this can confuse 
students, so we recommend using one or the other, not both. 
Can students access content after the due date? 

Yes. Due dates do not prevent access – they only mark when 
work should be completed. Students can still view content and 
submit assignments after a due date (submissions will be 
marked as late). 
Can students access content after the end date? 

No. End dates completely close access. Students cannot view 
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or submit anything after an end date passes. Use Special 
Access to provide extensions for individual students. 
Why don’t my discussion availability dates appear in the 
calendar? 

Unlike due dates, discussion availability dates (start/end dates) 
don’t automatically appear in the calendar. You need to check 
the “Add availability dates to Calendar” box when setting them. 
How do I give one student more time on an assignment or 
quiz? 

Use Special Access to create different dates or availability for 
specific students. This is commonly used for accommodations 
or extenuating circumstances. Learn more about Special 
Access 
What’s the difference between Hidden and using an 
availability start date? 

Both prevent student access, but they work differently: 

• Hidden: Students cannot see the item exists at all 
• Start date with “Visible with access restricted”: Students 

can see the item exists but cannot open it 

Choose based on whether you want students to know 
upcoming work exists. 
Will hiding a module hide the quizzes and assignments inside 
it? 

Not automatically. Students can still access quizzes, 
assignments, and discussions through the navigation bar even 
if the module is hidden or unavailable. To fully restrict access, 
you need to set availability dates or hide individual items as 
well. 
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Best Practices 

Be consistent with your approach: Choose a date strategy 
(due dates vs. availability windows) and use it consistently 
throughout your course. This helps students understand 
expectations. 

Communicate clearly: If you use both due dates and end 
dates, explain the difference in your assignment instructions. 
Let students know when on-time submissions are expected 
and when the window closes completely. 

Consider the student calendar: Remember that dates you 
add appear in students’ calendars alongside dates from all 
their other courses. Too many calendar items can overwhelm 
students and reduce the effectiveness of the calendar as a 
planning tool. 

Use visibility settings strategically: “Visible with submission 
restricted” is useful for discussions you want to keep open for 
reading but closed for posting. “Visible with access restricted” 
can build anticipation for upcoming assessments. 

Test your dates: Before your course goes live, impersonate 
a student (or use Student View) to verify that dates work as 
intended and that content appears or disappears as expected. 

Plan for extensions: If you regularly grant extensions, 
consider using due dates without end dates for most 
assignments. This allows late submissions while maintaining 
clear deadlines. 

Key Takeaways 
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• Due dates guide students about when work 
should be completed but don’t prevent late 
submissions 

• End dates completely close access – there’s no 
option for late work after an end date 

• Choose either due dates OR end dates for most 
items to avoid confusing students 

• Hidden items are completely invisible to 
students regardless of date settings 

• Use Special Access to provide accommodations 
or extensions for individual students 

• The Manage Dates tool provides a central 
location to review and edit all dates in your course 

Setting up availability dates and other restrictions 
can be complex, especially for high-stakes, 
time-sensitive activities. Contact EdTech if you’d like 
us to review your date settings. 

Further Resources 

• D2L: Add availability and due dates in Content 
• D2L: Set availability and due dates for an assignment 
• D2L: About Special Access for assignments 
• D2L: Manage Dates 
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Contact edtech@langara.ca for more information. 

If you are a Langara employee, self-register for Essentials 
to Excellence: A Brightspace Companion for Instructors. 
This Brightspace course compliments the technical 
instructions found here with use cases, examples, and 
advice. 
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Groups 

Having students work within smaller groups for 
specific projects or activities can increase 
engagement. The Brightspace Groups tool 
facilitates the setup and organization of group 
activities. Groups is often used in conjunction with 
Discussions and Assignments. 

Things to consider 

Before setting up Groups in Brightspace, consider preparing 
the following: 
Group Purpose 

Define clear objectives for using groups. Whether for 
discussions, assignments, or projects, having a well-defined 
purpose helps you select the appropriate group settings and 
communicates to students why they’re working in groups. 
Group Formation Strategy 

Decide how you want to form groups based on your 
pedagogical goals: 

• Random assignment works well for short-term activities 
• Self-enrollment gives students agency and may increase 

engagement 
• Instructor-assigned groups allow for balanced 

composition (skill level, experience, etc.) 
• Single-user groups can be useful for individual reflections 
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or sign-ups 

Group Size 

Consider the optimal size for your activity: 

• Smaller groups (2-3) encourage full participation but 
provide less diversity of perspectives 

• Medium groups (4-5) balance participation and diversity 
• Larger groups (6+) provide more perspectives but may 

lead to uneven participation 

Group Tools 

Determine which Brightspace tools the groups will use: 

• Discussion areas: For group conversations and 
collaborative idea development 

• Assignment folders: For group submissions of projects or 
assignments 

• Lockers: For file sharing among group members 

Timeline 

Plan the group activity timeline: 

• When will groups be formed? 
• How long will students work in these groups? 
• Do you need enrollment start/end dates for 

self-enrollment? 

Communication 

Prepare clear instructions for students about: 

• How to find their group 
• What they’re expected to do within their group 
• How to communicate with group members 
• How their group work will be evaluated 

Students can belong to multiple groups within the same 
course. For example, each student can simultaneously belong 
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to a group for the class project, a group for a special interest 
discussions, and group of one for journalling. Each group can 
have its own discussions forums, assignments, and locker area 
to work in. You can grade members of groups individually or as 
a team. 

To create groups in Brightspace: 

One or more interactive elements has been 

excluded from this version of the text. You can 

view them online here: https://pressbooks.bccampus.ca/

langaraquickguides/?p=1697#oembed-1 

Step-by-step guide to creating groups 

Step 1:  Go to My Tools > Groups. 

Step 2:  Click the New Category button to begin creating 
groups. 
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Step 3:  Enter a Category Name (required) and an optional 
description. 

• Choose a descriptive name that clearly identifies the 
purpose (e.g., “Project Teams” or “Discussion Groups Week 
3”) 

• The description can provide context for both you and your 
students 

Step 4:  Select the appropriate Enrollment Type based on 
your needs: 

Step 5:  Configure the 
Advanced Properties 
(options vary based on 
enrollment type): 

If you choose the Groups 
of # or # of 
Groups enrollment types, 
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• # of Groups – No Auto 
Enrollments: Creates 
empty groups for manual 
assignment (best when 
you want specific student 
combinations) 

• Groups of #: Creates 
groups with a specific 
number of members (e.g., 
“groups of 4 students 
each”) 

• # of Groups: Creates a 
specific number of total 
groups (e.g., “6 groups 
total”) 

• Groups of # – Self 
Enrollment: Allows 
students to join groups 
themselves (good for 
student agency) 

• Single User: Creates 
individual groups with one 
member each (useful for 
reflective activities or 
sign-ups) 

you will have three 
additional options 
under Advanced 
Properties. 

• Auto-enroll new users – If 
enabled, this setting will 
automatically add any new 
students to a group in this 
category if they are added 
to the course later. 

• Randomize users in 
groups – If enabled, this will 
enroll students in a random 
order. If this is not enabled, 
students will be enrolled 
based on their order in the 
classlist. 

• Make category and group 
descriptions visible to 
group members. 

For automatic enrollment, 
choose whether to 
randomize users in groups 
(recommended for most 
cases) 

For self-enrollment, set 
enrollment start and end dates if needed (e.g., give students 
one week to join) 

Step 6:  Select Additional Options as needed: 

• Discussion areas: Creates group-specific discussion 
forums where only group members can participate 

• Lockers: Provides file-sharing space for group members to 
exchange documents 

• Assignment submission folder: Creates a group 
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assignment submission area for collaborative work 

Step 7:  Click Save to create the groups. The system will 
process your request in the background. 

• You’ll see a notification that groups are being created 
• You can continue with other tasks while this processes 

Group Enrollment Types Explained 

When creating groups in Brightspace, you’ll need to choose 
how students will be assigned to groups. Here’s what each 
enrollment type means in plain language: 
Understanding Group Enrollment Types 

# of Groups – No Auto Enrollments 
What it means: You specify how many empty groups to create, 
with no students automatically added. 
Best for: When you want complete control over which students 
go into which groups. 
Example: Creating 5 project teams where you’ll manually place 
students based on their skills or interests. 

Groups of # 
What it means: You specify how many students should be in 
each group (e.g., groups of 4). 
Best for: When you have a specific group size in mind for 
effective collaboration. 
Example: Creating discussion groups with exactly 3 students 
per group for focused conversation. 

# of Groups 
What it means: You specify the total number of groups, and 
students are distributed evenly across them. 
Best for: When you need a specific number of groups 
regardless of exact size. 
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Example: Creating 6 lab groups to match the number of lab 
stations, with students evenly distributed. 

Groups of # – Self Enrollment 
What it means: You create groups with a maximum size, and 
students choose which group to join. 
Best for: When you want to give students agency in selecting 
their groups. 
Example: Creating “Topic Selection” groups where students 
join the topic that interests them most. 

Single User 
What it means: Each group contains exactly one student. 
Best for: Individual activities, sign-ups, or one-on-one 
interactions. 
Example: Creating presentation time slots where each student 
signs up for a specific time. 
Important Notes on Group Types 

• With automatic enrollment, students are assigned to 
groups in order from the class list unless you select 
“Randomize users in groups” 

• Self-enrollment can have a time limit (enrollment period) 
after which remaining students can be automatically 
assigned 

• Enrollment types determine which advanced properties 
are available to customize 

The group enrollment type options can be confusing. Watch 
the following video to get more information. 

One or more interactive elements has been 

excluded from this version of the text. You can 

view them online here: https://pressbooks.bccampus.ca/

langaraquickguides/?p=1697#oembed-2 
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• The maximum number of students per individual group is 
200. 

• Single user groups: this option can be used if you want to 
give students a personal space to journal that can only be 
accessed by the student and the instructor. 

• Users can belong to multiple groups within the same 
course but cannot self-enrol in more than one group in 
the same category. 

• “Restrict Enrolments To” will not be an available option in 
most situations, with the exception of a combined course 
that has more than one section. In that case, you can 
create groups that are restricted by section. 

Group Discussions 

Group discussions create focused conversation spaces where 
students can only see and interact with posts from members 
of their own group. This creates smaller, more manageable 
discussion communities within your course. 

When you enable group discussions: 

• Students can only view and respond to posts from their 
own group members 

• You (the instructor) can see and participate in all group 
discussions 

• Each group has its own dedicated discussion space 
• Grading is streamlined, making this ideal for assessed 

discussions 

You can set up group discussions in two ways: 

1. During group creation: Select “Discussion areas” under 
Additional Options when creating groups 

2. For existing groups: Create a new discussion topic and 
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link it to your group category 

Important: Once a discussion topic is created, you 
cannot convert it between a regular (open) topic and 
a group topic. Choose the right format from the 
beginning. 

For detailed instructions on creating discussions, visit the 
Discussions Quick Start Guide. 

Assignment Folders for Group 
Submissions 

Group assignment folders allow teams to collaborate on a 
single submission. This simplifies the submission process for 
group projects and ensures all team members have access to 
the same feedback. 

You can create group assignment folders in two ways: 

1. During group creation: Select “Assignment submission 
folder” under Additional Options when setting up groups 

2. For existing groups: Create a new assignment and link it 
to your group category during setup 

When using group assignment folders: 

• One submission represents the entire group’s work 
• All group members can contribute to the submission 
• Grades and feedback are shared with all group members 
• You can choose whether each student submits 

individually or the group submits once collectively 
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For complete instructions on creating assignments, visit the 
Assignments Quick Start Guide. 

Use Cases for Groups 

Collaborative Projects 
Create groups with an assignment folder to facilitate 
team projects. Students can collaborate on reports, 
presentations, or research tasks with shared 
submission and evaluation. 
Example setup: Groups of 4-5 students with both a 
group locker (for file sharing) and a group assignment 
folder (for final submission). 

Group Discussions 
Foster focused discussions on course topics by creating 
smaller discussion groups where students can engage 
more deeply with concepts. 
Example setup: Groups of 6-8 students with discussion 
areas only, using “Create one topic with threads 
separated by group” for easier monitoring. 

Peer Review Activities 
Set up groups where students can provide feedback on 
each other’s work through structured peer review. 
Example setup: Groups of 3 students with discussion 
areas for sharing feedback, possibly rotating groups for 
different assignments. 
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Individual Sign-up Slots 
Use single-user groups with self-enrollment to allow 
students to sign up for presentation times, lab sessions, 
or office hours. 
Example setup: Single-user groups with descriptive 
names like “Monday 10:00 AM Presentation” and 
self-enrollment option. 

 

Further Resources 

• See the student view of groups 
• Learn how to email groups 
• Find out how to modify groups 

Contact edtech@langara.ca for more information. 

If you are a Langara employee, self-register for Essentials 
to Excellence: A Brightspace Companion for Instructors. 
This Brightspace course compliments the technical 
instructions found here with use cases, examples, and 
advice. 
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Intelligent Agents 

Intelligent Agents are automated assistants that 
monitor student activity in your course and trigger 
actions based on criteria you define. They work 24/7 
to identify students who need support, recognize 
achievements, and help you stay informed about 
course engagement without constant manual 
monitoring. 

What You Can Do With Intelligent 
Agents 

Intelligent Agents can help you: 

• Welcome new students: Send an automated welcome 
message when students first access your course 

• Monitor engagement: Identify students who haven’t 
logged in or accessed course materials 

• Track progress: Alert you (or students) about missing 
assignments or incomplete activities 

• Provide timely support: Reach out to students who might 
be struggling based on assessment performance 

• Send reminders: Notify students about upcoming 
deadlines or important dates 

• Collect data: Generate weekly reports showing which 
students meet specific criteria without sending them 
emails 
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Think of Intelligent Agents as your teaching 
assistants who never sleep. They continuously 
monitor your course and take action when students 
meet (or don’t meet) the criteria you specify. 

Recommended Best Practices 

• Set custom email values before creating agents so 
messages come from you, not a generic system address 

• Start with instructor-only alerts (send emails to yourself) 
before automating student communication 

• Always test with Practice Run before enabling an agent 
• Use clear, descriptive naming conventions (e.g., “Week 2 

Engagement Check” not “Agent 1”) 
• Start with 1-2 simple agents before creating more complex 

ones 
• Avoid overwhelming students with too many automated 

messages 

Before You Begin: Set Custom 
Email Values 
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Before creating any Intelligent Agents, customize 
your email settings so messages come from you 
rather than a generic system address. This makes 
your communications look professional and ensures 
students can reply directly to you. 

1. Go to Course Admin > Intelligent Agents 
2. Click the Settings icon in the top right corner 
3. Select Set custom values for this course 
4. Enter your name in the Name that emails come from 

field 
5. Enter your Langara email address in the Reply-To address 

for responses field 
6. Click Save 

Important: Langara’s Brightspace does not have an 
internal email system. When Intelligent Agents send 
emails, they go to recipients’ Outlook inboxes. All 
subsequent communication happens through 
Outlook, outside of Brightspace. Make sure your 
reply-to address is an email account you regularly 
check. 

Your First Agent: Complete 
Walkthrough 
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Let’s create a simple Engagement Monitor agent that alerts 
YOU when students haven’t accessed your course in 5 days. 
This walkthrough shows every step with all options visible. 

We’re setting this up to email you (not students) 
because there are often legitimate reasons for low 
activity that the system can’t detect, such as 
students using the Brightspace Pulse mobile app 
(which doesn’t always register as “course access”), 
extensions you’ve granted, or personal 
circumstances you’re aware of. This approach gives 
you the data to make informed decisions about how 
to reach out. 

Step 1: Access and Name Your Agent 

1. Go to Course Admin > Intelligent Agents 
2. Click New Agent 
3. Enter Agent Name: “5-Day No Access Alert (Instructor 

Only)” 
4. Enter Description: “Weekly report of students who haven’t 

accessed course in 5 days” 
5. Category: Leave as “No Category” (you can organize later) 
6. Leave “Agent is enabled” UNCHECKED for now (you’ll test 

first, then enable) 

Step 2: Set the Schedule 

1. Click to expand Scheduling 
2. Under Frequency, select Weekly 
3. Set Repeats every: 1 week 
4. Select Repeats on: Monday (or your preferred day) 
5. Set Scheduled Time: 9:00 AM (or your preferred morning 
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time) 
6. Check Has Start Date and set it to your course start date 
7. Check Has End Date and set it to your course end date 

Why these settings? 
Weekly checks provide a regular pulse on student 
engagement without overwhelming you with daily 
reports. Monday morning timing lets you review the 
list and plan outreach for the week ahead. Start and 
end dates prevent the agent from running after 
your course finishes. 

Step 3: Define Your Criteria 

1. Click to expand Criteria 
2. Under Role in Classlist, select Users with specific roles 
3. Check the box next to Learner (leave other roles 

unchecked so TAs and instructors aren’t included) 
4. Under monitoring type, select Course Activity 
5. Select Has not accessed this course in the last [5] days 

Understanding monitoring types: 

• Login Activity: Checks if student logged into Brightspace 
at all (for any course). Use this if you want to know if 
students are accessing the system. 

• Course Activity: Checks if student accessed YOUR specific 
course. This is usually more meaningful because students 
might log in for other courses. 

• Release Conditions: More advanced – checks if students 
completed specific activities like viewing content or 
submitting assignments. Save this for your second or third 
agent. 
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Important limitation: Course Activity doesn’t always 
capture mobile app usage. Students using the 
Brightspace Pulse mobile app may not show as 
“accessed” even though they’re engaging with 
course content. This is another reason to use 
instructor-only alerts rather than automated 
student emails. 

Step 4: Configure Actions 

1. Click to expand Actions 
2. Under Repetition, select Take action every time the 

agent is evaluated and the agent’s criteria are satisfied 
for a user 

3. Check the box for Send an email when criteria are 
satisfied 

4. In the To field, enter: your email address (not 
{InitiatingUser}) 

5. Leave CC and BCC fields empty 
6. In the Subject field, type: Engagement Alert: Students 

with 5+ days no access in {OrgUnitCode} 
7. In the Message field, type your email (see example below) 

About repetition settings: 
For instructor-only reports, use “Every time” so you get 

weekly updates showing which students currently meet the 
criteria. This is different from student-facing agents where 
“every time” would send repeated emails to students. 

What are those weird codes? 
The codes like {OrgUnitCode} are called “replace strings.” 

Brightspace automatically swaps them with real information. 
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You’ll see a complete list in the next section. For now, just copy 
the example email below. 

Sample message to copy: 

The following students in {OrgUnitName} have not accessed the course in 5 or mor

This is an automated report to help you monitor engagement. Consider: 
- Checking if these students are using the mobile app (which may not register as course access) 
- Reviewing whether you've granted extensions or are aware of circumstances 
- Reaching out individually to students who might need support 

This report will run every Monday at 9:00 AM. 

Our Recommendation 
The email will automatically include a list of 
students who meet the criteria. You don’t need to 
use replace strings to insert student names – 
Brightspace adds that list automatically to 
instructor-only alert emails. 

Step 5: Test Your Agent 

1. Click Save and Close 
2. Find your agent in the list 
3. Click the dropdown arrow next to the agent name 
4. Select Practice Run 
5. Click Run in the confirmation window 
6. Check your email – you’ll receive a message showing 

which students currently meet the criteria 
7. Review the list to confirm it’s working as expected 
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Always practice run first. Practice runs show you 
which students currently meet the criteria. This is 
especially important for instructor-only alerts so you 
can verify the report format and student list before 
the agent runs automatically. 

Step 6: Enable Your Agent 

Once you’re satisfied with the practice run results: 

1. Click on the agent name to edit it 
2. Check the box for “Agent is enabled” 
3. Click Save and Close 

Your agent is now live and will run every Monday at 9:00 AM, 
sending you a report of students who haven’t accessed your 
course in 5 days. You can then decide individually how to 
respond to each student. 

Understanding Replace Strings 

Now that you’ve seen replace strings in action, here’s what they 
do: 

Replace strings are placeholder codes that Brightspace 
automatically fills with specific information for each recipient. 
When you type {InitiatingUserFirstName} in your email, 
Brightspace swaps it with “Sarah” for one student and 
“Michael” for another. This makes every email feel personally 
crafted without you writing individual messages. 

How to find them while creating an agent: 
While you’re composing your email in Step 4, look for the link 
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that says “What replacement strings can I use in the subject 
and message?” Click it to see the complete list available in 
Brightspace. 

Most commonly used replace strings: 
For the “To” field (recipients): 

• {InitiatingUser} – The student’s email address (the 
student who triggered the agent) 

For email subject and message: 

• {InitiatingUserFirstName} – Student’s first name (e.g., 
“Sarah”) 

• {InitiatingUserLastName} – Student’s last name (e.g., 
“Johnson”) 

• {OrgUnitName} – Full course name (e.g., “Introduction to 
Psychology”) 

• {OrgUnitCode} – Course code (e.g., “PSYC 1115”) 
• {LastCourseAccessDate} – Last date student accessed 

this course 
• {LastLoginDate} – Last date student logged into 

Brightspace 
• {LoginPath} – Direct link to Brightspace login page 

For the complete list of available replace strings, 
see D2L’s Replace Strings documentation. 

More Agents to Try 

Once you’re comfortable creating agents, try these additional 
examples. Note that these include both instructor-only alerts 
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and student-facing automated emails, each with guidance on 
when to use them. 
Welcome Message (Student-Facing) 

Purpose: Send an automated welcome email to students when 
they first access your course 

Settings: 

• Schedule: Hourly or daily 
• Criteria: Has accessed course for 1 day 
• Repetition: First time only 
• To field: {InitiatingUser} (sends to students) 

Sample email: 
Subject: Welcome to {OrgUnitCode} 
Dear {InitiatingUserFirstName}, 
Welcome to {OrgUnitName}. I’m looking forward to working 

with you this term. 
To help you get started: 

– Review the Course Outline under “Course Information” 
– Check the Schedule for important dates and deadlines 
– Introduce yourself in the “Introductions” discussion forum 
– Note that my office hours are [YOUR DAYS/TIMES] in [YOUR 
LOCATION] 

If you have any questions as you’re getting oriented, don’t 
hesitate to reach out. 

Best regards, 
[YOUR NAME] 

Our Recommendation 
Set the start date for this agent a few days before 
your course officially begins. This way, early-access 
students and those checking their course lists will 
receive your welcome message right away. 
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Welcome messages are low-risk for student-facing 
automation since all students benefit from them. 

Student Engagement Check-in (Student-Facing) 

Purpose: Send automated check-in email to students who 
haven’t accessed your course 

When to use student-facing vs. instructor-only: 

• Use instructor-only (like the walkthrough) when you 
want to review circumstances first 

• Use student-facing (this example) only if you’re 
comfortable with all flagged students receiving the same 
message regardless of individual circumstances 

Settings: 

• Schedule: Weekly (not daily, to avoid overwhelming 
students) 

• Criteria: Has not accessed course for 7 days 
• Repetition: First time only (critical for student-facing 

agents) 
• To field: {InitiatingUser} (sends to students) 
• CC field: Your email address (so you know who received 

messages) 

Sample email: 
Subject: Checking in regarding {OrgUnitCode} 
Dear {InitiatingUserFirstName}, 
I noticed you haven’t accessed our {OrgUnitName} course 

since {LastCourseAccessDate}. Regular engagement with 
course materials is important for success in this course. 

If you’re experiencing challenges or have circumstances 
affecting your participation, please reach out. I have office 
hours on [YOUR DAYS/TIMES] in [YOUR LOCATION], or we can 
arrange a virtual meeting. 
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You can access the course here: {LoginPath} 
Best regards, 

[YOUR NAME] 

Important considerations: This agent may email 
students who are using the Brightspace Pulse 
mobile app (which doesn’t always register as course 
access) or students with extensions you’ve granted. 
Make sure your message tone is supportive rather 
than accusatory, and always CC yourself so you’re 
aware of who received automated messages. 

Final Week Check-in (Student-Facing) 

Purpose: Offer support and remind students about resources 
as the term ends 

Settings: 

• Schedule: One-time run (set for week 11-12 of a 13-week 
term) 

• Criteria: All users visible in Classlist (with role “Learner” 
selected) 

• Repetition: First time only 

Sample email: 
Subject: Final weeks of {OrgUnitCode} – Support available 
Dear {InitiatingUserFirstName}, 
As we enter the final weeks of {OrgUnitName}, I wanted to 

remind you of support resources available: 
– Office hours continue through [DATE] at [TIMES] in 

[LOCATION] 
– The Learning Commons offers drop-in tutoring 
– Review sessions are scheduled for [DATES/TIMES] 
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– Final assignment due date: [DATE] 
– Final exam: [DATE/TIME/LOCATION if applicable] 

If you have questions about course content or your progress, 
please don’t wait until the last minute to reach out. 

You’ve put in good work this term. Finish strong. 
Best regards, 

[YOUR NAME] 

Our Recommendation 
Time this agent to run about 2 weeks before your 
final assessment or end of term. This gives students 
time to act on the information without feeling 
overwhelmed by last-minute reminders. 

Instructor-Only Data Collection Agent 

Purpose: Track student progress without sending automated 
emails to students 

Settings: 

• Schedule: Weekly (e.g., every Monday at 9 AM) 
• Criteria: Any criteria you want to monitor (e.g., hasn’t 

accessed course in 7 days) 
• Repetition: Every time 
• Action: In the “To” field, enter YOUR email address instead 

of {InitiatingUser} 

Why use this approach: 
Many instructors use agents primarily as data collection tools. 

You receive weekly reports showing which students meet your 
criteria (low grades, missed submissions, no logins, etc.), then 
you decide how to respond individually. 

This approach: 

• Respects your professional judgment about individual 
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circumstances 
• Allows you to consider extensions you’ve already granted 
• Lets you choose in-person conversations over automated 

emails 
• Maintains the human element in your teaching 

relationships 

For more on this approach, see Carleton’s guide to 
using Intelligent Agents for data reports. 

Managing Your Agents 

Viewing Agent Results 

To see which students received emails: 

1. Go to Course Admin > Intelligent Agents 
2. Check the Last Run Results column to see how many 

users met criteria 
3. Click the number to view the list of specific students 
4. Click the dropdown next to an agent and select View 

History to see all past runs 

Exporting results: 

1. Click the dropdown next to an agent 
2. Select Export History 
3. Set date range 
4. Check “Include Practice Runs” if needed 
5. Click Export to download a CSV file 
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Enabling, Disabling, and Deleting Agents 

To enable/disable an agent: 

• Click the agent name to edit it 
• Check or uncheck “Agent is enabled” 
• Click Save and Close 

To manually run an agent outside its schedule: 

• Click the dropdown next to the agent 
• Select Run Now 
• Click Run in the confirmation window 

To delete an agent: 

• Click the dropdown next to the agent 
• Select Delete 
• Confirm deletion 

You can restore deleted agents by clicking More 
Actions > Restore Deleted Agents on the main 
Intelligent Agents page. 

Copying Agents to Other Courses 

When you copy agents to another course, remember: 

• Agents are automatically disabled when copied 
• You must also copy any associated Release Conditions 
• You must also copy any activities referenced in the criteria 
• Schedule dates may need adjustment for the new term 

To copy: 

1. Use the standard Import/Export/Copy Components tool 
2. Select Intelligent Agents from the components list 

216  |  Intelligent Agents



3. Also select Release Conditions if your agents use them 
4. Complete the copy process 
5. Review and enable agents in the new course 

Tips for Success 

Start conservatively: Begin with 1-2 agents and expand as you 
see what works. Too many agents can overwhelm both you and 
your students. 

Consider instructor alerts first: Send emails to yourself to 
review data before deciding whether to contact students 
directly. This preserves your judgment about individual 
circumstances. 

Use categories for organization: If you create multiple 
agents, organize them by purpose (Engagement, Assessment, 
Recognition) or timing (Week 1, Week 5, Final Exam). 

Write in your voice: Even though emails are automated, they 
should sound like you. Use your normal tone and avoid overly 
formal language. 

Be thoughtful about timing: Schedule agents to run during 
working hours when you’re available to respond to student 
replies. Avoid middle-of-the-night emails that might increase 
student anxiety. 

CC yourself: Add your email to the CC or BCC field so you 
know exactly what students are receiving and can track who 
gets emails. 

Review and refine: Check agent results periodically. If an 
agent isn’t working as intended, adjust the criteria or schedule. 

Document successful agents: Keep notes about which 
agents work well so you can quickly set them up in future 
course offerings. 

Respect accessibility: Use clear language, specific subject 
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lines, and proper HTML formatting (headers, links) to support 
students using screen readers. 

Further Resources 

• D2L: About Intelligent Agents 
• D2L: Set Up Intelligent Agents 
• D2L: Replace Strings Reference 
• Carleton: Using Intelligent Agents for Data Reports 

Contact edtech@langara.ca for more information. 

If you are a Langara employee, self-register for Essentials to 
Excellence: A Brightspace Companion for Instructors 
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Self-Registration 

Some Brightspace courses are available for 
self-registration. These are often asynchronous 
training or information courses. 

To Self-Register in a Brightspace 
Course 

Step 1 

Login to Brightspace and select the Self Registration link 
on the top left. 

Step 2 

Select the course from the available course list. 

Step 3 
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Click the Register button on the bottom right. 

Step 4 

Click Submit. 

Step 5 

Click Finish and you’re registered in the course. 
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The course will now appear on your Brightspace home page 
and the course selection menu. 

Tip: You can pin the course to the top of your home page by 
clicking the ellipsis (…) on the top right of the course and select 
Pin. 
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Contact edtech@langara.ca for more information. 
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Class Progress 

Class Progress provides a centralized dashboard 
for monitoring student engagement and 
performance across your course. Track content 
completion, assignment submissions, discussion 
participation, grades, and login activity all in one 
place to identify students who may need support. 

What You Can Do With Class 
Progress 

Class Progress helps you: 

• Monitor engagement at a glance: See which students are 
actively participating and which may be falling behind 

• Track multiple metrics: View up to 4 performance 
indicators simultaneously (content completion, grades, 
discussion activity, login history, and more) 

• Identify at-risk students: Quickly spot students who 
haven’t logged in recently or aren’t completing required 
activities 

• View individual progress: Drill down into detailed reports 
for specific students 

• Prepare progress reports: Export data or review 
comprehensive summaries for advising conversations 
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Class Progress is particularly useful during weeks 
3-5 of term when patterns of engagement become 
clear, and again before midterms when early 
intervention can make a difference. 

Accessing Class Progress 

1. Open your course in Brightspace 
2. In the navbar, select Progress 
3. In the dropdown menu, select Class Progress 

You’ll see a dashboard displaying all students in your course 
with 4 performance indicators shown by default: 

• Content Completed: Shows how many required content 
topics each student has completed 

• Objectives: Displays progress toward learning objectives (if 
you’ve set them up) 

• Logins: Number of times student logged into Brightspace 
(system-wide, not course-specific) in the last 30 days 

• Grades: Current final grade plus visualization of last 15 
grade items 

Important: Login data shows system-wide logins to 
Brightspace, not course-specific access. A student 
might log in for other courses without accessing 
yours. For course-specific access, use the Course 
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Access indicator (see Customizing Indicators section 
below). 

Understanding the Dashboard 

Reading the Visualizations 

Each performance indicator uses visual cues to highlight 
student progress: 

Content Completed: 

• Bar shows percentage of required content topics 
completed 

• Hover over the bar to see exact numbers (e.g., “5 of 10 
topics”) 

• Green indicates high completion, red indicates low 
completion 

Grades: 

• Shows current final grade percentage 
• Bar chart visualizes performance across last 15 grade items 
• Hover to see specific assignment scores 

Logins: 

• Number shows total logins in last 30 days 
• Absent period indicates days since last login (e.g., “Oct 30, 

2024 – absent period: 3” means student didn’t log in for 3 
days) 

Filtering by Groups or Sections 

If your course uses groups or sections: 
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1. At the top of the Class Progress page, look for the filter 
dropdown 

2. Select a specific group or section to view only those 
students 

3. This is helpful for large courses or when different sections 
have different requirements 

Viewing Individual Student 
Progress 

Accessing a Student’s Progress Report 

1. From the Class Progress dashboard, click on a student’s 
name 

2. You’ll see their Progress Summary page with detailed 
information about their course activity 

The Progress Summary includes: 

• Summary: Overview of overall progress 
• Content: Which content topics they’ve viewed and time 

spent on each 
• Assignments: Submission status and scores 
• Quizzes: Attempts and scores 
• Discussions: Posts, replies, and read status for each forum 
• Grades: Detailed grade breakdown 
• Course Access: Days visited in last 30 days and access 

history 

Navigation tip: Use the left-hand menu to jump directly to a 
specific tool section, or scroll down and click the dropdown 
arrows to expand each section. 
Navigating Between Students 

When viewing an individual student’s progress report: 
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• Use the navigation arrows below the student’s name at 
the top to move to the next/previous student 

• Click Class Progress above the student’s name to return to 
the full class dashboard 

This makes it easy to review multiple students in sequence 
without returning to the main dashboard each time. 
Checking Course Access (Course-Specific Activity) 

To see when a student actually accessed YOUR course (not just 
logged into Brightspace): 

1. Click on the student’s name from the Class Progress 
dashboard 

2. In the left menu, select Course Access 
3. You’ll see: 

◦ Number of days visited in the last 30 days 
◦ Last accessed date 
◦ List of all course access dates 

Our Recommendation 
Course Access provides more useful engagement 
data than Login History since it shows 
course-specific activity. Unfortunately, Course 
Access can only be viewed in individual student 
reports, not on the main dashboard. To monitor 
course-specific engagement, you’ll need to review 
individual student reports or use System Access as 
your dashboard indicator. 
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Customizing Your Dashboard 
Indicators 

You can display any 4 of the 9 available progress indicators. 
Choose the ones most relevant to your teaching priorities. 

Available Progress Indicators 
• Content Completed: Required content topics completed 

(must set content as “required” for tracking) 
• Objectives: Learning objectives achieved (requires 

objectives to be set up and linked) 
• Assignment Submissions: Assignment completion status 
• Grades: Current final grade and recent performance 
• Checklist Completion: Checklist items completed 

(requires checklists) 
• Content Visited: Content topics viewed (whether required 

or not) 
• Discussion Participation: Posts and replies in discussion 

forums 
• Login History: System-wide logins to Brightspace in last 

30 days 
• Quiz Performance: Quiz attempts and scores 
• Survey Completion: Survey responses 
• System Access: Times student accessed Brightspace (via 

browser or Pulse app) in last 30 days 

Note about Course Access: Course Access (which 
shows when students accessed YOUR specific 
course, not just Brightspace) is only available when 
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viewing individual student reports. It cannot be 
added as a dashboard indicator. To check 
course-specific access, you must click on a student’s 
name and select “Course Access” from the left 
menu. 

To Change Which Indicators Display 

1. From the Class Progress dashboard, click Settings in the 
top-right corner 

2. You’ll see your current 4 indicators listed in numerical 
order (1-4) 

3. Click the dropdown arrow next to the indicator you want 
to replace 

4. Select Replace 
5. In the popup window, choose a new indicator from the list 
6. Click Save and Close 

The new indicator will immediately appear on your dashboard. 

To Reorder Indicators 

1. From the Class Progress dashboard, click Settings 
2. Click the dropdown arrow next to an indicator 
3. Select Move Up or Move Down 
4. Click Save and Close 

Recommended Indicator Combinations 
For online courses: Content Completed, 
Assignment Submissions, Discussion Participation, 
Grades 
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For blended courses: Content Visited, Assignment 
Submissions, Quiz Performance, Grades 
For engagement monitoring: System Access, 
Content Completed, Discussion Participation, 
Assignment Submissions 

Setting Up Content Tracking 

For the Content Completed indicator to work, you must mark 
content topics as “Required.” By default, all content in 
Brightspace is set to “Not Required.” 
Setting Individual Content Items as Required 

To make a specific content topic required: 

1. Go to Course Content 
2. Find the content topic you want to track 
3. Click the dropdown arrow next to the topic 
4. Select Edit Properties 
5. Under Completion, check Required 
6. Choose completion type: 

◦ Automatic: Marks complete when student views the 
content 

◦ Manual: Student must click a “Mark Complete” button 

7. Click Save and Close 

Setting All Future Content as Required by Default 

To automatically make all new content required: 

1. Go to Course Content 
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2. Click Settings (gear icon) in the top right 
3. Scroll down to Completion Tracking 
4. Under Default Completion Status, select: 

◦ Required Automatic: All new content automatically 
marked complete when viewed 

◦ Required Manual: All new content requires students 
to click “Mark Complete” 

5. Click Save 

Important: Changing the default setting only affects 
NEW content you create. Existing content remains 
“Not Required” unless you manually change each 
item. 

Checking Which Students Completed Specific Content 

To see completion status for a specific content item: 

1. Go to Course Content 
2. Open the content topic you want to check 
3. Scroll to the bottom of the page 
4. Click the Completion Summary tab 
5. You’ll see a list of students who have/haven’t completed 

the activity 

This is useful for checking specific required readings or 
activities without reviewing full student progress reports. 

Using Class Progress for Early 
Intervention 
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Week 3-5 Check: Review Class Progress to identify students 
who: 

• Haven’t accessed the course in 7+ days 
• Have completed less than 50% of required content 
• Haven’t submitted early assignments 
• Show no discussion participation 

Before Midterms: Check again to: 

• Identify students with low grades who might benefit from 
support resources 

• Spot students who’ve stopped engaging after initial 
participation 

• Reach out proactively before students fall too far behind 

Combining with Intelligent Agents: Set up an Intelligent 
Agent to automatically alert you when students meet 
concerning criteria (e.g., no course access in 7 days). Then use 
Class Progress to get the full picture of their engagement 
before reaching out. 

Printing or Exporting Progress 
Reports 

To print an individual student’s progress report: 

1. Open the student’s Progress Summary page 
2. Click the Print icon in the top right 
3. Your browser’s print dialog will open 
4. You can print or save as PDF 

This is useful for advising meetings or documentation 
purposes. 

232  |  Class Progress



Note: There is no built-in export function for the 
full class dashboard. To track changes over time, 
consider taking screenshots or manually recording 
data at key points in the term. 

Limitations and Considerations 

Login vs. Course Access: The default “Logins” indicator shows 
system-wide logins, not course-specific access. Students using 
the Brightspace Pulse mobile app may not register as “logged 
in” at all. Use Course Access (in individual reports) for more 
accurate course engagement data. 

30-Day Window: Login and access data only covers the last 
30 days. Historical data beyond this window is not available. 

Content Tracking Requires Setup: Content Completed only 
tracks items marked as “Required.” If you haven’t set content as 
required, this indicator won’t provide useful data. 

Real-Time vs. Cached Data: Some indicators update 
immediately while others may have a slight delay. Grade 
changes typically reflect quickly, while content completion 
may take a few minutes to update. 

While we advocate the use of Class Progress to 
provide guidance, students using the Pulse mobile 
app to access the course content does not register 
properly in Class Progress. According to Brightspace 
“Class Progress > Course Access does not currently 
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incorporate Pulse course access data as expected. 
This is a known limitation.” 

Please be aware that Class Progress is not a 
definitive record of student access and progress 

Tips for Success 

Choose indicators that align with your course structure: If 
your course is heavily discussion-based, prioritize Discussion 
Participation. If it’s content-focused, use Content Completed or 
Content Visited. 

Check Class Progress weekly: Regular monitoring helps you 
catch issues early when intervention is most effective. Consider 
making it part of your Monday morning routine. 

Focus on patterns, not single data points: A student missing 
one login isn’t cause for alarm, but missing both content 
completion AND assignment submissions AND discussion 
posts suggests genuine disengagement. 

Combine with personal outreach: Class Progress provides 
data, but conversation provides context. Use the data to 
identify who to reach out to, then have actual conversations to 
understand what’s happening. 

Set up Intelligent Agents for automated monitoring: 
Configure agents to alert you when students meet concerning 
criteria, then use Class Progress to investigate further before 
deciding how to respond. 

Mark key content as required from the start: If you want to 
track content completion, set up your Content settings before 
students begin accessing materials. It’s harder to track 
retroactively. 

234  |  Class Progress



Use System Access or Content Visited for engagement: 
Since Course Access isn’t available as a dashboard indicator, 
use System Access (shows Brightspace usage via browser or 
Pulse app) or Content Visited (shows which content students 
have viewed) to monitor engagement patterns on your main 
dashboard. 

Further Resources 

• D2L: About Class Progress 
• D2L: Set Up Class Progress 
• Intelligent Agents Quick Guide 

Contact [email protected] for more information. 

If you are a Langara employee, self-register for Essentials to 
Excellence: A Brightspace Companion for Instructors 
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PADLET 

Padlet  |  237



238  |  Padlet



Padlet 

Padlet is a real-time collaborative web platform for 
sharing, collaborating, and organizing. Padlet 
creates virtual bulletin boards called “Padlets” in a 
range of formats and styles. 
 
Use Padlet for: 

• Introductions 
• Discussions 
• Brainstorming 
• Project Planning 

• Collaboration 
• Team-building 
• Resource curation 
• Presenting 

• Showcasing student work 
• Peer evaluation 
• Exit tickets 
• Concept mapping 
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Langara has a limited number of licenses for Padlet. 
Contact edtech@langara.ca to obtain a license. 

Getting Started with Padlet 

1. Visit the Langara Padlet login page and use the Padlet 
credentials provided via email. 

2. On the Padlet dashboard, click Make a padlet (in the top 
right corner). 

Making Padlets 
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Blank 

If you choose a blank board, 
you start from scratch. Give 
your board a Title, choose the 
Format of the board, and the 
level of organization of your 
posts. 

Choose between a Blank 
board or a template from the 
Gallery – hover over the 
templates in the gallery to 
see how they can be used. 
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Template 

If you choose a template, your 
Padlet will include additional 
instructions, information, and 
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examples of use. 

Update your Padlet settings by 
clicking the cog icon on the 
right-hand side. 

Padlet Settings 
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In the Settings menu you can 
change the Heading, 
Appearance, Layout, 
Engagement, Posts, and 
Content settings of your 
Padlet. 

Update your Padlet 
permissions settings by 
opening the Share menu – 
click the arrow icon on the 

Share your Padlet 
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right-hand side. 
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Change your Visitor 
permissions (under the 
Collaborators heading) from 
No access to Reader, Writer, or 
Moderator.

Sharing 

Move to the Share tab to 
share your Padlet with your 
students using a link, QR 
code, embed into 
Brightspace or PebblePad, 
etc. 
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Visit the Padlet Help website for more information or contact 
edtech@langara.ca 
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MICROSOFT TOOLS 
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Microsoft Forms 

Microsoft Forms can enhance audience 
engagement and provide real-time feedback via 
polling. Live polls can be seemlessly incorporated in 
Microsoft PowerPoint presentations to collect, and 
display, responses in real-time. Forms can also 
collect feedback and other data. A form embedded 
in your Brightspace course can make asynchronous 
data and feedback collection easier. 

To Access Microsoft Forms 

1. Login to Microsoft365. 
2. Select Apps on the left side toolbar. 
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3. Click All apps and select Forms. 
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To create a Form: 

1. Click on New Form on the top left. 

2. Give your Form a meaningful and unique title. 
3. Select a question type to begin. 

Question options include: Choice, Text, Rating, Date, 
Ranking, and Likert. 

4. Enter question details. 

◦ Adjust settings for each question, such as making a 
question required, allowing multiple answers, and 
adding branching based on response. 
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5. Continue to Add new question. 

To collect responses asynchronously: 

1. Select Collect Responses. 

2. Forms can be shared via URL, directly in Outlook or Teams, 
via QR code, or embed code.

Permissions can be set to allow anyone, authenticated 
users (with an option for anonymous responses), or 
specific people to respond. 
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Note: EdTech recommends the Anyone can 
respond option as this allows respondents to 
remain anonymous and does not require them to 
login with their Microsoft credentials. 

Microsoft Forms automatically saves your work. You can find all 
items you have created under My forms. 

Tips for Effective Polling 

• Keep It Simple: Use clear and concise questions to avoid 
confusion. 

• Engage Early: Incorporate a poll early in your presentation 
to capture attention. 

• Encourage Participation: Remind your audience to 
participate and explain how their feedback will be used. 

• Analyze Results: Use the poll results to gauge 
understanding and adapt your presentation accordingly. 

Microsoft Forms is part of Langara’s Microsoft 365 
Suite of tools and has undergone required privacy 
and risk assessments. 
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Contact edtech@langara.ca for more information. 
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Microsoft Forms Quiz 

Microsoft Forms Quiz is a specific feature within 
Microsoft Forms tailored for creating quizzes and 
assessments, particularly for educational purposes. 
It can create engaging, self-paced knowledge 
assessments, allowing for a deeper understanding 
of asynchronous learning progress. It includes all the 
features of Microsoft Forms, but with additional 
capabilities specific to creating quizzes such as 
assigning points to questions and setting correct 
answers. Microsoft Forms Quizzes also provides 
features for automatically grading responses and 
providing immediate feedback to students. 
Use Microsoft Forms Quizzes for: 

• Practice quizzes 
• Knowledge checks 

To Access Microsoft Forms 

1. Login to Microsoft365. 
2. Click Apps on the left side toolbar. 

Microsoft Forms Quiz  |  257

https://www.microsoft365.com/


3. Click All apps and select Forms 

Creating a Quiz 

1. Click New Quiz on the top left. 
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2. Give your Quiz a title and then click Add new. 

3. Build your quiz by choosing from the question types. 

4. Add point values to your questions and mark them as 
Required, if necessary. 

Note: Additional options are available depending on the 
type of question – clicking the ellipsis (…) brings up more 
options. 

5. Once all questions are added, click the ellipsis on the top 
right corner of your quiz and select Settings to verify your 
quiz settings before sharing – determine if the quiz is for 
practice, if results will be shown to students after 
submitting, the start and end date, the quiz duration, etc. 
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Microsoft Forms automatically saves your work. You can find all 
items you have created under My forms. 

Sharing a Quiz 

Once your quiz settings are verified, share your quiz in one of 
two options: Collect response or Present. 

Collect Response 

Collect responses allows you to copy a link of your quiz, 
create an invitation, download a QR code, or copy an embed 
code. 

Present 

Present converts your quiz into a slideshow presentation. 
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The quiz can be completed synchronously, and 
visualizations update in real-time. 

Responses can be collected anonymously or 
participants can be required to login via their 
Langara email address. A spreadsheet with all the 
responses can be downloaded. Reach out to EdTech 
for more assistance. 

Contact edtech@langara.ca for more information. 
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Presenting Microsoft Forms in 
PowerPoint 

Forms and quizzes created in Microsoft Forms can 
be integrated directly into PowerPoint, allowing for 
real-time engagement and knowledge checks. 

Inserting Microsoft Forms in PowerPoint (Windows 
desktop app): 

1. On a new PowerPoint slide, click the Insert tab and select 
Forms. 

2. Select the form/quiz from the Forms sidebar and click 
Insert. 
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3. When presenting live, choose Present for Interactive 
meetings. To collect asynchronous responses, choose 
Collect responses offline. 

Inserting Microsoft Forms in PowerPoint (MacOS 
desktop app): 

1. On a new PowerPoint slide, move to the Home tab, open 
My Add-ins and choose Forms. 

2. Paste the link to your form in the Insert your form into a 
slide window. 
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3. When presenting live, choose Present for Interactive 
meetings. To collect asynchronous responses, choose 
Collect responses offline. 

4. Adjust the Form placement: 

◦ Resize and move the embedded form on your slide as 
needed. 

Inserting Microsoft Forms in PowerPoint (web browser): 

1. On a new PowerPoint slide, click the Home tab > Add-ins 
> Forms. 

2. Paste the link to your form in the Insert your form into a 
slide window.
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3. When presenting live, choose Present for Interactive 
meetings. To collect asynchronous responses, choose 
Collect responses offline. 

4. Adjust the Form placement: 

◦ Resize and move the embedded form on your slide as 
needed. 

To Collect Responses: 

1. Start the PowerPoint Presentation. 
2. Engage Your Audience: 

◦ When you reach the poll slide, instruct your audience 
to participate by scanning the QR code or entering the 
link. 

◦ If you wish to have participants respond to the form/
quiz prior to displaying the live results, insert a slide 
before with the QR code and link to the form/quiz. 

3. Wait while audience members respond to the poll in 
real-time. 

4. Display Results: 

◦ As responses come in, you can display the results live 
on your slide. 

◦ Discuss the results with your audience to enhance 
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interaction. 

Contact edtech@langara.ca for more information. 
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Microsoft Forms FAQ 

Getting Started: 

What is Microsoft Forms, and how can I access it? 

Microsoft Forms is an online tool that allows you to create 
surveys, quizzes, and polls, as well as collect responses in real 
time. It’s user-friendly and integrates seamlessly with other 
Microsoft 365 apps, making it a great choice for checking in, 
gathering feedback, conducting assessments, and more in an 
educational setting. 

Accessing Microsoft Forms: 
1. Login to Microsoft365. 
2. Click Apps on the left side toolbar. 
3. Click All apps and select Forms. 

How do I create a new form or quiz in Microsoft Forms? 

See the Microsoft Forms Quick Start Guide for instructions on 
creating a new Form. 

See the Microsoft Forms Quiz Quick Start Guide for 
instructions on creating a new Quiz. 
What is the difference between a form and a quiz in Microsoft 
Forms? 

A Form is used for collecting information or feedback (e.g., 
surveys, polls), while a Quiz is designed for assessments where 
you can assign point values to questions and provide 
automatic feedback. In quizzes, you can also track correct/
incorrect answers and give grades. 
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Customization and Design: 

What types of questions can I create? 

Select from a range of question types, including: 

• Choice (multiple choice) 
• Text (open-ended answers) 
• Rating (star or number ratings) 
• Date (ask for a date) 
• Likert (scale for agreement levels) 

Add the question, provide answer options (if creating a quiz), 
and set any additional options like required responses or 
multiple answers. 
Can I add images, videos, or other media to my form/quiz? 

Yes, you can add media to enhance your form or quiz: 

1. For questions, click the Image or Video icon next to the 
question text field to upload a file or provide a URL. 

2. You can also insert media directly into your form’s title 
section to make it more visually appealing. 

3. Ensure your media complies with accessibility guidelines 
for all users. 

How can I reorder or edit questions in a form/quiz? 

To reorder questions: 

Click the drag handle ( ) at the top of the question 
and reorder the question. 
or 
Click on the question you want to move and use the up 
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or down arrow ( ) next to the question to change 
its position. 

To edit a question: 

1. Click on the question itself to make changes. 
2. You can modify the text, answer choices, or settings (e.g., 

required field) directly in the editor. 

If you want to change a question type, delete the question and 
add new. 

Collaboration and Sharing: 

How do I share my form/quiz with colleagues or students? 

1. Click Collect Responses in the upper-right corner of the 
form you wish to share. 

2. Choose your sharing options: 

◦ Anyone with the link can respond (for public access, 
anonymous, no sign-in required) 

◦ Only people in Langara College can respond (for 
internal use, can record name, sign-in required) 

◦ Specific people in  Langara College can respond (for 
internal use, can record name, sign-in required) 

3. Copy the link, generate a QR code, or share directly via 
email or Teams. You can also embed the form on 
Brightspace, in PowerPoint, and in OneNote. 

Can I collaborate with others on creating or editing a form/
quiz? 

Yes! To collaborate: 
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1. Click the ellipsis on the top right corner of the form and 
select Collaborate or Duplicate. 

2. Click Share the link to collaborate and view result. 
3. Choose from the dropdown, who can collaborate on your 

form/quiz. We recommend sharing with Specific people in 
Langara College with the link can edit and view result. 

4. Copy and Share the link with colleagues 

How can I insert my form/quiz into PowerPoint? 

See the Presenting Microsoft Forms in PowerPoint Quick Guide 
for instructions. 

Data Collection and Analysis: 

How can I view and analyze responses from my form/quiz? 

To view responses: 

1. Go to the Responses tab at the top of your form. 
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2. Here, you can see a summary of all responses with charts 
and graphs. 

3. For a more detailed view, click View Results to see 
individual responses. 

For advanced analysis: 

1. Click the Excel Spreadsheet to view all the response data. 
2. You can sort, filter, and analyze responses. 

How do I set up notifications for new responses? 

To receive notifications for new responses: 

1. In the Settings menu(gear icon) on the top right of your 
form/quiz, check the box next to Get email notification of 
each response. 

2. Provide the email you wish to receive notifications. 
3. You will receive an email every time a new response is 

submitted. 

Can I set a deadline for responses? 

Yes, you can set a deadline: 

1. Go to the Settings menu (gear icon) on the top right of 
your form/quiz. 

2. Check the option for Start Date and End Date. 
3. Set the dates and times for when the form will open and 

close to responses. 

Troubleshooting: 

Why aren’t my responses showing up correctly? 
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If responses aren’t showing correctly: 

1. Ensure the form is still open and hasn’t been closed or 
restricted. 

2. Check if any filters or validation settings are affecting the 
responses. 

3. Make sure all respondents are using updated browsers 
and devices. 

If the issue persists, try exporting the responses to Excel to see 
if the data is captured but not displaying. 
Additional Resources: 

• LinkedIn Learning Microsoft Forms Quick Tips 
• Share a form or quiz to collaborate 
• Check and share your form results 
• View results of your form 

Contact edtech@langara.ca for more information. 
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Quizzes 
The Quizzes tool in Brightspace can be used for different types 
of assessments. Quizzes offer numerous question types. 
Extended Time Accommodation 

Extended Time Accommodation 

Welcome to EdTech Tips, a message with helpful, 
focused advice for improving your experience with 
educational technologies. 

The Accommodations tool allows you to set up modified quiz 
time for individual students directly in the Classlist, so one 
setup applies across every quiz in the course.When a student 
has an extended time accommodation, go to the Classlist and 
select Edit Accommodations beside the student’s name. 
From there, activate Modify Time Limit and either apply a 
multiplier of the original time or add a specific number of 
extra minutes. Once saved, you’ll see an accommodation icon 
next to the student’s name in the Classlist confirming the 
setting is in place, though the accommodation itself won’t be 
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visible inside the quiz settings. 
For step-by-step instructions, visit Setting up Quiz 
Accommodations on the Brightspace Instructor Help site. 

Did you know? 

The time multiplier in the Accommodations tool 
applies automatically to every quiz in the course. You 
don’t need to set it up quiz by quiz, which means less 
manual work and fewer chances for something to slip 
through. 

The Accommodations tool only adjusts time limits. If 
a student needs different availability dates, a 
different due date, or additional attempts, you’ll 
need to use Special Access within the individual 
quiz settings to cover those adjustments. 

The Accommodations tool is one of several Brightspace 
features designed to reduce administrative overhead while 
supporting your students. For more, visit Langara’s Brightspace 
Instructor Help site. 

Contact EdTech 
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Brightspace 
Communication Tips 

Brightspace allows you to communicate with your students 
using various tools. Consider the following tips for best 
practices with Brightspace’s communication tools. 
Copying Announcements 

Copying Announcements 
Between Courses 

Welcome to EdTech Tips, a message with helpful, 
focused advice for improving your experience with 
educational technologies. 

The Announcements tool enables you to create 
announcements that communicate with your users quickly 
and effectively. For information about 
creating new announcements, visit the Brightspace Instructor 
Help Page. 
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Instructors frequently run into difficulties when they copy 
their course from a previous semester to the current one. It is 
important to note that, if you have selected Copy All 
Components during the Import process, 
the Announcements from the previous semester are copied 
as well. 

Often all these Announcements will be active and visible to 
students. This is because, when the Announcement was 
created, No End Date was set up. To make them inactive, you 
must set an end date for each Announcement. If you do not 
have a specific end date for the Announcement, you can add 
the end of the semester as the end date. That way, when the 
course is copied over the next term, the announcement 
remains inactive, and you can change the start date and end 
date and reuse them whenever you want. 

Did you know? 

When you copy from an existing course, it may be better 
practice to copy less than you need, especially things 
with dates. Instead of using “Copy All Components”, 
select “Copy Selected Components” and choose what is 
useful going forward. 

Please note that when you, as the 
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instructor, Dismiss an announcement, the 
announcement is only dismissed from your view. It 
is not hidden from all the students. 

Use Announcements to communicate essential information to 
your learners. Keep in mind, information from last semester 
is no longer essential and copied Announcements will be 
confusing. 

Want to learn more about the Announcements tool? Visit 
the Brightspace Instructor Help article about Announcements. 

Contact EdTech 
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Brightspace Course 
Management Tips 

Practical tips for managing your Brightspace courses before, 
during, and after the semester. 
Exporting a Course Package 

Exporting a Brightspace Course 
Package 

Welcome to EdTech Tips, a message with helpful, 
focused advice for improving your experience with 
educational technologies. 

When a course ends, most of us move on without thinking 
twice about what happens to it in Brightspace. But if you’ve 
built something you’re proud of and want to make sure you 
always have access to it, it’s worth taking a few minutes to 
export a copy for yourself. 

Brightspace makes it easy to download a complete course 
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package, which is a snapshot of your course content, structure, 
and settings that you can store on your own device or in cloud 
storage. 

There are a few situations where having your own copy 
makes a lot of sense. If you’re going on leave, moving between 
institutions, or just want a clean archive of a course you’ve 
refined over several semesters, a local copy is a more reliable 
long-term solution than a DVP course. It also keeps things tidy 
for everyone, since DVP courses accumulate over time and add 
to the overall storage load in Brightspace. 

Did you know? 

Unlike a Development (DVP) course, which lives in 
Brightspace and requires the system to stay accessible, 
a downloaded package belongs to you. You control it, it 
doesn’t depend on any platform, and it can be 
re-imported into Brightspace later if you need it. Note 
that a course export does not include student data like 
grades, quiz attempts, or submission folder files. 

Important: When your export is complete, save the 
.zip file as-is. Do not open it or re-compress it, as 
doing either will make the package unusable and it 
cannot be imported back into Brightspace. If you 
have a large course and the export times out, try 
exporting in smaller chunks, for example, content 
and course files first, then other components 
separately. For best results, export on a wired 
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internet connection rather than WiFi. 

If you’d like help with the export process, D2L’s documentation 
on exporting course components walks you through it step by 
step. As always, feel free to reach out to the EdTech team if you 
have questions. 

Contact EdTech 
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